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(J2EE), and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle Corporation 
in the U.S. and other countries.
All other product and company names and marks mentioned in this document are the property of their 
respective owners and are mentioned for identification purposes only.
THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT ALL 
OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED AT THE SAME 
TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE VERSION ON A SPECIFIC 
OPERATING SYSTEM PLATFORM.
THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.
THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. 
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE 
INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE 
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN 
THIS DOCUMENT AT ANY TIME.
THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING 
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.
Copyright © 2007-2016 TIBCO Software Inc. All rights reserved.
TIBCO Software Inc. Confidential Information
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Preface

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Salesforce.com plugs into 
TIBCO ActiveMatrix BusinessWorks™ and can be installed separately. You can 
use this plug-in to configure a connection to the Salesforce.com server, and then 
use activities, such as Salesforce Query All, to integrate with the Salesforce.com 
database. 

This document describes the product concepts and features in detail, and helps 
you get started easily by providing hands-on examples.

Topics

• Related Documentation, page xii

• Typographical Conventions, page xiv

• Connecting with TIBCO Resources, page xvii
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Related Documentation

This section lists documentation resources you might find useful. 

TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com Documentation
The following documents form the TIBCO ActiveMatrix BusinessWorks Plug-in 
for Salesforce.com documentation set:

• TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com Installation Read 
this manual for instructions on site preparation and installation.

• TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com User’s Guide Read 
this manual for instructions on using the product on all platforms.

• TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com Release Notes Read 
the release notes for a list of new and changed features. This document also 
contains lists of known issues and closed issues for this release.

Other TIBCO Product Documentation
You might find it useful to read the documentation for the following TIBCO 
products:

• TIBCO ActiveMatrix BusinessWorks™

• TIBCO Adminstrator™

• TIBCO Business Studio™

• TIBCO Designer™

• TIBCO Hawk®

• TIBCO Runtime Agent™

• TIBCO Rendezvous®

Third-Party Documentation
The following documents from Salesforce.com are related to TIBCO ActiveMatrix 
BusinessWorks Plug-in for Salesforce.com. They are available from the 
Salesforce.com website:

• Force.com Web Service API Developer's Guide: this manual provides 
programmatic access to your organization’s information using a simple, 
TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com User’s Guide
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powerful, and secure application programming interface, the ApexWeb 
Services API (the API).

• Apex Developer’s Guide: this manual provides information about what Apex is, 
how Apex works, and the Apex development process. 
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions

Convention Use

ENV_NAME

TIBCO_HOME 

TIBCO products are installed into an installation environment. A product 
installed into an installation environment does not access components in other 
installation environments. Incompatible products and multiple instances of the 
same product must be installed into different installation environments.

An installation environment consists of the following properties:

• Name Identifies the installation environment. This name is referenced in 
documentation as ENV_NAME. On Microsoft Windows, the name is 
appended to the name of Windows services created by the installer and is a 
component of the path to the product shortcut in the Windows Start > All 
Programs menu. 

• Path The folder into which the product is installed. This folder is referenced 
in documentation as TIBCO_HOME. 

SFDC_HOME TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com is installed into a 
directory within TIBCO_HOME. This directory is referenced in documentation 
as SFDC_HOME. The default value of SFDC_HOME depends on the operating 
system. For example, on Windows systems, the default value is 
C:\tibco\bw\plugins\salesforce.

BW_HOME BW_HOME is the directory on the host where TIBCO ActiveMatrix 
BusinessWorks is installed. The value of BW_HOME depends on operating 
systems. For example, on Windows systems the value can be C:\tibco\bw\5.9.

USER_HOME The user’s home directory.

code font Code font identifies commands, code examples, filenames, pathnames, and 
output displayed in a command window. For example:

Use MyCommand to start the foo process.
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bold code 

font 
Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of 
particular interest.

• In command syntax, to indicate the default parameter for a command. For 
example, if no parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]

italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO ActiveMatrix 
BusinessWorks Concepts.

• To introduce new terms For example: A portal page may contain several 
portlets. Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. 
For example: MyCommand PathName

Key 
combinations

Key name separated by a plus sign indicate keys pressed simultaneously. For 
example: Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the 
other. For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for 
example, an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply 
the information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, 
data loss or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use
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Table 2   Syntax Typographical Conventions

Convention Use

[ ] An optional item in a command or code syntax.

For example: 

MyCommand [optional_parameter] required_parameter

| A logical OR that separates multiple items of which only one may be chosen.

For example, you can select only one of the following parameters: 

MyCommand param1 | param2 | param3

{ } A logical group of items in a command. Other syntax notations may appear 
within each logical group.

For example, the following command requires two parameters, which can be 
either the pair param1 and param2, or the pair param3 and param4.

MyCommand {param1 param2} | {param3 param4}

In the next example, the command requires two parameters. The first parameter 
can be either param1 or param2 and the second can be either param3 or param4:

MyCommand {param1 | param2} {param3 | param4}

In the next example, the command can accept either two or three parameters. 
The first parameter must be param1. You can optionally include param2 as the 
second parameter. And the last parameter is either param3 or param4.

MyCommand param1 [param2] {param3 | param4}
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Connecting with TIBCO Resources

How to Join TIBCOmmunity
TIBCOmmunity is an online destination for TIBCO customers, partners, and 
resident experts. It is a place to share and access the collective experience of the 
TIBCO community. TIBCOmmunity offers forums, blogs, and access to a variety 
of resources. To register, go to http://www.tibcommunity.com.

How to Access TIBCO Documentation
Documentation for this and other TIBCO products is available on the TIBCO 
Documentation site: 

https://docs.tibco.com

Documentation on the TIBCO Documentation site is updated more frequently 
than any documentation that might be included with the product. To ensure that 
you are accessing the latest available help topics, please visit us at 
https://docs.tibco.com.

How to Contact TIBCO Support
For comments or problems with this manual or the software it addresses, contact 
TIBCO Support as follows:

• For an overview of TIBCO Support, and information about getting started 
with TIBCO Support, visit this site:

http://www.tibco.com/services/support

• If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user 
name, you can request one.
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Chapter 1 Plug-in Introduction

This chapter gives an overview of Salesforce.com and TIBCO ActiveMatrix 
BusinessWorks Plug-in for Salesforce.com. 

Topics

• Overview of Salesforce.com, page 2

• Overview of TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com, 
page 3
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Overview of Salesforce.com

Salesforce.com is the worldwide leader in on-demand customer relationship 
management (CRM) services. It delivers integrated and completely customizable 
enterprise applications for companies of all sizes. 

Salesforce.com provides a web services Application Programming Interface (API) 
to customers and Independent Software Vendors (ISVs) who want to build 
integrations. Although web services are incredibly powerful, customers might 
run into a number of limitations when trying to build enterprise-class integrations 
quickly and easily.

Customers, partners, and consultants build the same common components 
during each integration effort. These components, including session 
management, exception handling, logging, process management, configuration 
management, reliable transactions, and polling services, are necessary for every 
enterprise-class integration implementation.
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Overview of TIBCO ActiveMatrix BusinessWorks Plug-in for 

Salesforce.com

TIBCO ActiveMatrix BusinessWorks is an easy-to-use integration software that 
provides world-class integration technology in a rapid deployable solution that 
manages the entire lifecycle of integration projects. TIBCO ActiveMatrix 
BusinessWorks Salesforce.com Plug-in plugs into TIBCO ActiveMatrix 
BusinessWorks and can be installed separately. You can use this plug-in to 
configure a connection to the Salesforce.com server, and then use activities, such 
as Salesforce Query All to integrate with the Salesforce.com database.

TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com provides the 
following common functionalities for integrating with the Salesforce.com server:

• Easy-to-configure connection configuration shared resources that can be 
reused for different activities and processes.

• Get Session activity that provides a simple interface and hides all the details of 
complex session management tasks, such as login, session expiration, and so 
on.

• Metadata Management with which you can build metadata at design time 
and store the metadata as XML Schema Definition (XSD) schemas, which in 
turn is used at run time to perform runtime type-checking.

• High level data calls, such as Create All, Query All, Update All, Upsert All, 
Retrieve All, and Delete All. Each of these activities has built-in error handling 
and logging.

• Dynamically Web Service Definition Language (WSDL) switching with which 
you can work with different versions of Salesforce.com Partner and Enterprise 
WSDLs. 

• Outbound Message Listener with which you can receive notifications from the 
Salesforce.com server.

• Relationship Query that can be used to query multiple sObjects at a time in 
the Salesforce.com database. Relationships are created between those 
sObjects. Sforce Object Query Language (SOQL) provides the syntax to 
support relationship queries. Parent-to-children and child-to-parent are the 
two possible relationships between sObjects. 
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Plug-in Components
Using TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com 
components, you can create plug-in projects that run as a standalone process. 
This plug-in component is referred to as the Standalone plug-in.

Standalone plug-in projects are created and configured using TIBCO Designer 
and deployed using TIBCO Administrator. 
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Chapter 2 Salesforce Tools

This chapter describes the Salesforce tools used in TIBCO ActiveMatrix 
BusinessWorks Plug-in for Salesforce.com. 

Topics

• Select WSDL, page 6

• Get Metadata, page 9

• Refresh Metadata, page 12
 TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com User’s Guide
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Select WSDL

Web Services Description Language (WSDL) is an XML-based language that can 
be used to describe the services a business offers and to provide a way for 
individuals and other businesses to access those services electronically. 

Importing a WSDL
When working with TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com, you must select a WSDL for your project. 

To select a WSDL, perform the following steps:

1. Start TIBCO Designer, and then create a new project.

2. Click Tools > Salesforce Tools > Select WSDL from the TIBCO Designer 
menu. The Select WSDL dialog is displayed.

3. Select a WSDL you want to work with from the Salesforce WSDL list. The 
default WSDL is Partner 30.0 WSDL. If you select Other WSDLs from the 
Salesforce WSDL list, you have to locate the corresponding WSDL file in your 
computer. 

4. Click OK, the Importing Selected WSDL dialog is displayed. 

a. If you click Yes, the selected WSDL is imported, and the Server URL is also 
substituted based on the selected WSDL. 

b. If you click No, only the selected WSDL is imported. 

Default WSDL
In TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com, all available 
WSDLs and the SalesforceWSDLs.xml file that defines the WSDLs shown in the 
Salesforce WSDL list are located in the SFDC_HOME\wsdls directory.

If you do not select a WSDL for your project, the default WSDL is automatically 
imported into the project when you create a Salesforce Connection shared 
resource in the project. The default WSDL is defined in the first wsdl node in the 
SalesforceWSDLs.xml file. See Figure 1. 

This manual uses the Partner 30.0 WSDL to describe the Salesforce activities. For 
each activity, the fields in the Input, Output, and Error Output tabs are generated 
from the Partner 30.0 WSDL. If you select a WSDL other than this WSDL in a 
project, the Input, Output, and Error Output fields might be different from the 
fields explained in Chapter 3, Salesforce Palette. 
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Figure 1   Default WSDL in the XML File 

SalesforceResources Folder
In the project you just created, if the WSDL is successfully selected, the 
SalesforceResources folder is displayed in the Project panel. It is used to store 
Salesforce resource files related to your current project. The resource files include 
the WSDL files, metadata files, and so on. 

Switching WSDL
TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com contains two 
types of Salesforce.com WSDLs, the Partner WSDL and the Enterprise WSDL. You 
can select only one WSDL for your project. If you want to switch the current 
WSDL to another one, you have to perform the Select WSDL operation again and 
pay attention to the following guidelines:

You cannot rename, edit, or delete the WSDL and the metadata files in the 
SalesforceResources folder. 

You can add other files to the SalesforceResources folder. 
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• When switching WSDLs between two different versions of Partner WSDLs, 
you have to perform the Select WSDL operation to import a target WSDL first, 
and then update the metadata on the Salesforce.com server. For more 
information, refer to Refresh Metadata on page 12. 

• When the Partner WSDL is replaced with an Enterprise WSDL, all metadata 
files related to the original Partner WSDL are erased from the 
SalesforceResource folder. The Enterprise WSDL contains its own metadata 
that can be used in your process. 

• When the Enterprise WSDL is replace with a Partner WSDL, you have to 
select a Partner WSDL first, and then perform the Get Metadata operation to 
obtain the metadata from the Salesforce.com server. 

• If the WSDL is changed, the Server URL string in all the Salesforce 
configuration resources is updated according to your choice. See step 4 in 
Importing a WSDL on page 6. If you want to set the Server URL to be a 
specific address, you have to manually change the value in the Server URL 
field in the Configuration tab. 

• For the Salesforce activities, the fields in the Input, Output and Error Output 
tabs are parsed from the certain WSDL. After the WSDL is changed, the 
mapping configuration for the fields mentioned previously might be affected. 
You have to repair the incorrect mappings. See TIBCO ActiveMatrix 
BusinessWorks Process Design for more information. 

The Server URL in all the Salesforce configuration resources must be the same version as 
the selected WSDL. 
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Get Metadata

The Salesforce_Metadata resource describes the schema definition metadata for a 
given organization as an XML schema definition (XSD). To obtain the metadata, 
you must perform the following tasks:

• Setting Up a Salesforce Connection, page 9

• Retrieving the Metadata, page 10

Task A Setting Up a Salesforce Connection

Before retrieving metadata for your project, you must set up a Salesforce 
connection, which you can download and store metadata as an XSD resource in 
the TIBCO ActiveMatrix BusinessWorks project during design time.

To set up a Salesforce connection, perform the following steps:

1. Start TIBCO Designer, and then select the project you created in Importing a 
WSDL on page 6.

2. Drag the Salesforce Connection icon from the Palettes panel to the Design 
Panel.

3. Enter the user name and password in the Configuration tab, and then click 
Test Connection. Click OK in the Test Connection Succeeded dialog. See 
Salesforce Connection on page 17 for more information.

If you have installed TIBCO ActiveMatrix BusinessWorks 5.13, when you 
attempt to connect to the Salesforce.com server, the connection fails and the 
following error is thrown:
javax.net.ssl.SSLHandshakeException: Received fatal alert: 
handshake_failure

Use java.property.TIBCO_SECURITY_VENDOR=j2se property in
<TIBCO_HOME>\designer\<VERSION>\bin\designer.tra file for running on designer. For admin
deployment add it to <TIBCO_HOME>\bw\<VERSION>\bin\bwengine.tra file.
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Figure 2   Setting Up a Salesforce Connection Successfully

Task B Retrieving the Metadata

To retrieve the metadata from the Salesforce.com server, perform the following 
steps:

1. Click Tools > Salesforce Tools > Get Metadata. The Get Metadata dialog is 
displayed. 

2. Use the default schema name or type one you want to use. 

Click Browse next to the Salesforce Connection field, and the Select a 
Resource dialog is displayed. Select one of the listed usable connections in the 
dialog to your current activity, and then click OK.

3. Click OK to retrieve the metadata from the Salesforce.com server. Click OK 
when the metadata has been retrieved successfully.

After retrieving the metadata from the Salesforce.com server, the sforce_partner 
schema and Salesforce_Metadata schema are displayed in the 
SalesforceResources folder in the Project panel. See Figure 3. 
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Figure 3   Retrieving the Metadata Successfully

• The sforce_partner schema stores some public data properties. 

• The Salesforce_Metadata schema is a metadata schema that comes from a 
specified database on the Salesforce.com server. 

When selecting an Enterprise WSDL for your project, you do not have to perform the Get 
Metadata operation to retrieve Salesforce metadata. The Enterprise WSDL contains 
Salesforce metadata. 
 TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com User’s Guide



12 | Chapter 2  Salesforce Tools
Refresh Metadata

The Refresh Metadata operation can be used to retrieve updated schema from the 
Salesforce.com server. Schema objects might change between the development 
phase and the production phase, or over the time. It is important for you to decide 
to accept or reject the change. If you accept the change, you are warned that all 
processes referring to the metadata might be impacted. 

To refresh metadata from the Salesforce.com server, perform the following steps:

1. Click Tools > Salesforce Tools > Refresh Metadata. The Refresh Metadata 
dialog is displayed. 

2. Click OK to perform the operation.

— If no update is available on the metadata on the Salesforce.com server, then 
just click the relevant buttons to finish the operation.

— If the metadata on the Salesforce.com server is different from the local 
metadata, the Salesforce Metadata Update dialog is displayed. See 
Figure 4. Fields modified on the Salesforce.com server are displayed in the 
dialog. 

Figure 4   Salesforce Metadata Update Dialog

When selecting an Enterprise WSDL for your project, if you want to refresh the metadata, 
you must regenerate the WSDL file from the Salesforce.com server and then import the 
new WSDL file to your project. 
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3. Click Yes to accept the updated result. Click No to reject this result. Click Save 
As to save the result to an XML file. 
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Chapter 3 Salesforce Palette

This chapter describes the salesforce palette, which contains shared configuration 
resource and salesforce activities for TIBCO ActiveMatrix BusinessWorks Plug-in 
for Salesforce.com. 

Topics

• Palette Overview, page 16

• Salesforce Connection, page 17

• Salesforce Get Session, page 31

• Salesforce Create All, page 19

• Salesforce Delete All, page 26

• Salesforce Query All, page 34

• Salesforce Retrieve All, page 42

• Salesforce Update All, page 48

• Salesforce Upsert All, page 55

• Salesforce Outbound Message Listener, page 62
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Palette Overview

Salesforce palette is available from the Palettes panel in TIBCO Designer. This 
section describes the shared configuration resource, activities, and process starter.

• Salesforce Connection, page 17

• Salesforce Create All, page 19

• Salesforce Delete All, page 26

• Salesforce Get Session, page 31

• Salesforce Query All, page 34

• Salesforce Retrieve All, page 42

• Salesforce Update All, page 48

• Salesforce Upsert All, page 55

• Salesforce Outbound Message Listener, page 62

Figure 5   Salesforce Palette 
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Salesforce Connection
Shared Configuration

The Salesforce Connection shared resource describes a connection to the 
Salesforce.com server. Salesforce connections are used when you specify activities 
from the Salesforce palette.

Configuration Tab
Table 3 lists and explains the fields in the Configuration tab.

Table 3   Salesforce Connection Configuration Tab

Field Global Var? Description

Name No The resource name. The default value is Salesforce Connection.

Description No Short description of the resource.

Server URL Yes The URL to be used when the plug-in connects to the Salesforce.com 
server. 

After selecting a WSDL for your project, the URL information is 
automatically filled in this field. 

Note: You must maintain one Server URL when configuring the whole 
Salesforce project. 

User Name Yes The user name to access the Salesforce.com server. 

Password Yes The password to access the Salesforce.com server. 

Note: You must append the security token to your password. A security 
token is an automatically generated key from Salesforce.com. For 
example, if your password is mypassword, and your security token is 
XXXXXXXXXX, you must enter mypasswordXXXXXXXXXX to log in. 

For detailed information on when to use a security token and how to 
generate it, see Force.com Web Service API Developer's Guide.

Session 
Timeout
(min)

Yes Specifies the duration for which the session is active. The value set here 
must be less than or equal to the value set on the Salesforce.com website. 
See Figure 6. 

The default value is 120 minutes.

Test 
Connection

No Click this button to test whether the specified configuration fields 
result in a valid connection to a database on the salesforce.com server.
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Figure 6   Set Session Timeout Value on the Salesforce.com Website
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Salesforce Create All
Activity

The Salesforce Create All activity adds one or more new individual objects to the 
data of your organization. 

Configuration Tab
Table 4 lists and explains the fields in the Configuration tab.

Input Tab
The Input tab contains the Process Data panel and the Activity Input panel. The 
information in the Process Data panel gives an overview of all the processes. The 
Activity Input panel provides the parameters that you can specify or change for 
all activities. Table 5 lists and explains the Activity Input fields in the Input tab.

Table 4   Salesforce Create All Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

Salesforce 
Connection

Yes Path to the shared configuration resource containing the salesforce 
connection information. 

Click the Browse button next to the Salesforce Connection field to 
open the Select a Resource dialog. All usable connections are listed in 
the dialog. Select one to apply to your current activity.

Table 5   Salesforce Create All Input Tab: Activity Input (Sheet 1 of 6)

Input Items Data Type Description

connectionInfo (All fields in this section are optional.)

serverUrl String URL of the endpoint that is used by this operation.

sessionId String Unique ID associated with this session.
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externalSessionIdUsed Boolean Specifies whether an external session ID is used (true) or 
not (false).

If the value is set to true, an external session ID is filled in 
the sessionId field.

When the session has to be refreshed, the refresh operation 
cannot be performed, and an exception is thrown. 

create

batchSize Integer Optional. When processing large amounts of data, the 
activity internally invokes several SOAP calls. This field is 
used to set the batch size for the number of records created 
through a SOAP call.

The value ranges from 1 and 200:

• If the input value equals to -1, it will be set to the 
default value. 

• If the input value is greater than 200, it will be set 
to 200. 

• If the input value is less than 1 (except -1), it will 
be set to 1. 

• The default is 200.

externalIdFieldName String Optional. This field is used when you perform the retry 
operation. An internal upsert method is called to perform 
the retry operation. If this field is not specified when you 
perform the retry operation, an exception is thrown and the 
retry operation fails. 

This field contains the name of the field defined as a key 
field in the sObject.

createSObjects

Table 5   Salesforce Create All Input Tab: Activity Input (Sheet 2 of 6)

Input Items Data Type Description
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sObjects Complex Required. An array of one or more objects to be created. 
This sObject can be converted to the specified type defined 
in the metadata schema, for example, the 
Salesforce_Metadata schema, retrieved from the 
Salesforce.com server. 

Note: 

• In this release, you can create up to 10 object types in 
one call. Right-click type > Statement > Duplicate to 
add multiple object types. See Figure 7 on page 24.

• You do not have to specify the Id field in the sObject.

To create a new relationship between a newly created 
sObject (sObject A) and an existing sObject (sObject B), 
where the sObject A schema includes the sObject B 
schema, set the value of the key field in sObject B while 
creating sObject A. If you modify the values of the 
fields in sObject B within the sObject A schema, the 
original sObject B will not be modified. The key field in 
sObject B within the sObject A schema is only used to 
link sObject A with the original sObject B. 

create_Optional (All fields in this section are optional.)

_configData

timeout Integer Specifies the number of milliseconds an internal API call 
waits before the data is returned. 

The default value is 15000 milliseconds. 

You can also change the default timeout value by setting 
the properties. See Default Timeout Value Setting on 
page 103 for detailed information.

headers

CallOptions

client String A string that identifies a particular client.

defaultNamespace String A string that identifies a developer namespace prefix. Use 
this field to resolve field names in managed packages 
without having to fully specify the fieldName 
everywhere.

AssignmentRuleHeader

Table 5   Salesforce Create All Input Tab: Activity Input (Sheet 3 of 6)

Input Items Data Type Description
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assignmentRuleId String ID of a specific assignment rule to run for Case or Lead. It 
can be an inactive assignment rule. The ID can be retrieved 
by querying the AssignmentRule object. If this field is 
specified, set the value in the useDefaultRule field to 
false. This element is ignored for Account, because all 
territory assignment rules are applied.

Case and Lead are two predefined Salesforce.com schema 
types. For more information about these two types, see 
Force.com Web Service API Developer's Guide. 

useDefaultRule Boolean If the value of the useDefaultRule field is set to true for 
Case or Lead, the default (active) assignment rule for Case 
or Lead is used. If this field is specified, do not specify an 
assignmentRuleId and type an empty string in the 
assignmentRuleId field. If the value of the useDefaultRule 
field is set to true for Account, all territory assignment 
rules are applied; if the value is set to false, no territory 
assignment rules are applied.

MruHeader

updateMru Boolean Specifies whether to update the list of most recently used 
items (true) or not (false), which is on the sidebar in the 
Salesforce.com user interface.

AllowFieldTruncationHeader

allowFieldTruncation Boolean Specifies whether to truncate field values that are too long 
(true) or not (false). 

The default value is false: no change in behavior. If a 
string or text area value is too large, the operation fails and 
the error code STRING_TOO_LONG is returned.

DisableFeedTrackingHeader

disableFeedTracking Boolean If the value of this item is set to true, the changes made in 
the current call are not tracked in feeds.

The default value is false.

StreamingEnabledHeader

streamingEnabled Boolean Specifies whether you want to receive streaming 
notifications for changes to Salesforce data.

Table 5   Salesforce Create All Input Tab: Activity Input (Sheet 4 of 6)

Input Items Data Type Description
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AllOrNoneHeader

allOrNone Boolean If the value of the allOrNone field is set to true, any failed 
records in a call cause all changes for the call to be rolled 
back. Record changes are not committed unless all records 
are processed successfully.

The default value is false. Some records can be processed 
successfully although others are marked as failed in the call 
results.

Note: When processing large amounts of data, the activity 
internally invokes several SOAP calls. However, this 
AllOrNoneHeader only applies to each internal SOAP 
call. If the value of the allOrNone field is set to true, the 
records in each internal SOAP call will all succeed or be 
rolled back.

DebuggingHeader

debugLevel String Specifies the level of detail in the debug header.

See the Salesforce.com document Apex Developer’s Guide for 
detailed information. 

The response of the debugging information can be found in 
the SOAP message log. You might have to enable the debug 
role log for tracing the debugging errors. 

PackageVersionHeader

PackageVersion

majorNumber Integer The major version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

minorNumber Integer The minor version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

namespace String The unique namespace of the managed package.

EmailHeader

Table 5   Salesforce Create All Input Tab: Activity Input (Sheet 5 of 6)

Input Items Data Type Description
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Figure 7   Creating Multiple Object Types

triggerAuto
ResponseEmail

Boolean Specifies whether to trigger auto-response rules (true) or 
not (false), for leads and cases. In the Salesforce.com user 
interface, this email can automatically triggered by a 
number of events, for example, resetting a user password.

triggerOtherEmail Boolean Specifies whether to trigger an email outside the 
organization (true) or not (false). In the Salesforce.com 
user interface, this email can be automatically triggered by 
creating, editing, or deleting a contact for a case.

triggerUserEmail Boolean Specifies whether to send an auto-response email to the 
owner specified in the owner ID (true) or not (false).

Table 5   Salesforce Create All Input Tab: Activity Input (Sheet 6 of 6)

Input Items Data Type Description
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Output Tab
Table 6 lists and explains the fields in the Output tab.

Error Output Tab
Table 7 lists and explains the possible exceptions. 

Table 6   Salesforce Create All Output Tab

Output Item Data Type Description

createAllResponse

result

errors Complex If errors occur during the activity, an array of Error objects with the error 
code and description will be returned.

id String ID of an sObject that you attempt to create. 

success Boolean Indicates whether the create activity succeeds (true) or not (false).

Table 7   Salesforce Create All Error Output Tab

Exception Thrown when 

SalesforceExecuteSOAP
MethodException

An error occurs when a SOAP method is called. 

For example, a wrong value is set in the Input field or the Salesforce session 
times out. 

SalesforceLoginException An error occurs when you logs on to the Salesforce.com server. 

SalesforceConnection
NotFoundException

An error occurs when the external session ID is not used and the Salesforce 
Connection shared resource is not configured correctly.
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Salesforce Delete All
Activity

The Salesforce Delete All activity deletes one or more individual objects from the 
data of your organization.

Configuration Tab
Table 8 lists and explains fields in the Configuration tab.

Input Tab
The Input tab contains the Process Data panel and the Activity Input panel. The 
information in the Process Data panel gives an overview of all of the processes. 
The Activity Input panel provides the parameters that you can specify or change 
for all activities. Table 9 lists and explains the Activity Input fields in the Input 
tab.

Table 8   Salesforce Delete All Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

Salesforce 
Connection

Yes Path to the shared configuration resource containing the salesforce 
connection information. 

Click the Browse button to open the Select a Resource dialog. All 
usable connections are listed in the dialog. Select one to apply to your 
current activity.

Table 9   Salesforce Delete All Input Tab (Sheet 1 of 4)

Input Items Data Type Description

connectionInfo (All fields in this section are optional.)

serverUrl String URL of the endpoint that is used by this operation.

sessionId String Unique ID associated with this session.
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externalSessionIdUsed Boolean Specifies whether an external session ID is used (true) or 
not (false).

If the value is set to true, an external session ID is filled in 
the sessionId field.

When the session has to be refreshed, the refresh 
operation cannot be performed, and an exception is 
thrown. 

delete

batchSize Integer Optional. When processing large amounts of data, the 
activity internally invokes several SOAP calls. This field is 
used to set the batch size for the number of records 
deleted through a SOAP call.

The value ranges from 1 to 200:

• If the input value equals -1, it is set to the default 
value. 

• If the input value is greater than 200, it is set to 
200. 

• If the input value is less than 1 (except -1), it is 
set to 1. 

• The default value is 200.

deleteSObjects

ids String Required. An array of one or more IDs associated with the 
objects to be deleted.

delete_Optional (All fields in this section are optional.)

_configData

timeout Integer Specifies the number of milliseconds an internal API call 
waits before the data is returned. 

The default value is 15000 milliseconds. 

You can also change the default timeout value by setting 
the properties. See Default Timeout Value Setting on 
page 103 for detailed information.

Table 9   Salesforce Delete All Input Tab (Sheet 2 of 4)

Input Items Data Type Description
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headers

DebuggingHeader

debugLevel String Specifies the level of detail in the debug header.

See Apex Developer’s Guide for detailed information. 

The response of the debugging information can be found 
in the SOAP message log. You might have to enable the 
debug role log for tracing the debugging errors. 

AllowFieldTruncationHeader

allowFieldTruncation Boolean Specifies whether to truncate field values that are too long 
(true) or not (false). 

The default value is false: no change in behavior. If a 
string or text area value is too large, the operation fails and 
the error code STRING_TOO_LONG is returned.

DisableFeedTrackingHeader

disableFeedTracking Boolean If the value of this field is set to true, the changes made in 
the current call are not tracked in feeds.

The default value is false.

StreamingEnabledHeader

streamingEnabled Specifies whether you want to receive streaming 
notifications for changes to Salesforce data.

PackageVersionHeader

PackageVersion

majorNumber Integer The major version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

minorNumber Integer The minor version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

namespace String The unique namespace of the managed package.

Table 9   Salesforce Delete All Input Tab (Sheet 3 of 4)

Input Items Data Type Description
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EmailHeader

triggerAuto
ResponseEmail

Boolean Specifies whether to trigger auto-response rules (true) or 
not (false), for leads and cases. In the Salesforce.com 
user interface, this email can be automatically triggered by 
a number of events, for example, resetting a user 
password.

triggerOtherEmail Boolean Specifies whether to trigger an email outside the 
organization (true) or not (false). In the Salesforce.com 
user interface, this email can be automatically triggered by 
creating, editing, or deleting a contact for a case.

triggerUserEmail Boolean Specifies whether to send an auto-response email to the 
owner specified in the owner ID (true) or not (false).

UserTerritoryDeleteHeader

transferToUserId String The ID of the user to whom open opportunities in that 
user's territory are assigned when the owner (user) of an 
opportunity is removed from a territory.

CallOptions

client String A string that identifies a particular client.

defaultNamespace String A string that identifies a developer namespace prefix. Use 
this field to resolve field names in managed packages 
without having to fully specify the field name 
everywhere.

AllOrNoneHeader

allOrNone Boolean If the value of the allOrNone field is set to true, any 
failed records in a call cause all changes for the call to be 
rolled back. Record changes are not committed unless all 
records are processed successfully.

The default value is false. Some records can be 
processed successfully although others are marked as 
failed in the call results.

Note: When processing large amounts of data, the activity 
internally invokes several SOAP calls. However, this 
AllOrNoneHeader only applies to each internal SOAP 
call. If the value of the allOrNone field is set to true, the 
records in each internal SOAP call will all succeed or be 
rolled back.

Table 9   Salesforce Delete All Input Tab (Sheet 4 of 4)

Input Items Data Type Description
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Output Tab
Table 10 lists and explains fields in the Output tab.

Error Output Tab
Table 11 lists and explains the possible exceptions in the Error Output tab. 

Table 10   Salesforce Delete All Output Tab

Output Item Data Type Description

deleteAllResponse

result

errors Complex If errors occur during the activity, an array of Error objects with the error 
code and description, is returned.

id String ID of an sObject that you attempted to delete.

success Boolean Indicates whether the delete activity succeeds (true) or not (false).

Table 11   Salesforce Delete All Error Output Tab

Exception Thrown when 

SalesforceExecuteSOAP
MethodException

An error occurs when a SOAP method is called. 

For example, a wrong value is set in the Input field or the Salesforce session 
times out. 

SalesforceLoginException An error occurs when you logs on to the Salesforce.com server. 

SalesforceConnection
NotFoundException

An error occurs when the external session ID is not used and the Salesforce 
Connection shared resource is not configured correctly.
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Salesforce Get Session
Activity

The Salesforce Get Session activity retrieves an object reference for the specified 
salesforce connection and obtains an existing session. This session can be used 
within salesforce activities to access the specified database. 

Configuration Tab
Table 12 lists and explains the fields in the Configuration tab.

Table 12   Salesforce Get Session Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

Salesforce 
Connection

Yes Path to the shared configuration resource containing the Salesforce 
connection information. 

Click the Browse button to open the Select a Resource dialog. All usable 
connections are listed in the dialog. Select one to apply to your current 
activity.
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Input Tab
The Input tab contains the Process Data panel and the Activity Input panel. The 
information in the Process Data panel gives an overview of all the processes. The 
Activity Input panel provides the parameters that you can specify or change for 
all activities. Table 13 lists and explains the fields in the Input tab.

Output Tab
Table 14 lists and explains the fields in the Output tab.

Table 13   Salesforce Get Session Input Tab

Input Item Data Type Description

login

salesforceConnection String Optional. Path to the shared configuration resource containing 
the salesforce connection information.

The priority of this field is higher than the Salesforce Connection 
field in the Configuration tab. If you want to change the 
referenced salesforce connection resource at run time, you can set 
the salesforceConnection field.

refreshSession Boolean Optional. Specifies whether a new session can be initiated.

The value is set to be true if you always want to obtain a new 
session. 

The value is set to false if the existing session is used. The 
obtained session might not be usable if it has timed out. But the 
performance time in this situation is faster. 

Table 14   Salesforce Get Session Output Tab

Output Item Data Type Description

salesforceConnection String Path to the shared configuration resource containing the salesforce 
connection information. 

Indicates that the Salesforce Get Session activity uses this 
salesforce connection resource at run time. 

loginResponse

result
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Error Output Tab
Table 15 lists and explains the exceptions that can be thrown by this activity.

metadataServerUrl String URL of the endpoint that processes subsequent metadata API 
calls.

passwordExpired Boolean Indicates whether the password used during the login attempt has 
expired (true) or not (false).

sandbox Boolean Specifies whether the Salesforce environment is a sandbox or not.

serverUrl String URL of the endpoint that processes subsequent API calls.

sessionId String Unique ID associated with this session.

userId String ID of the user associated with the specified user name and 
password.

userInfo Complex User information fields. 

Table 14   Salesforce Get Session Output Tab (Cont’d)

Output Item Data Type Description

Table 15   Salesforce Get Session Error Output Tab

Exception Thrown when 

SalesforceLoginException An error occurs when you logs on to the Salesforce.com server. 

SalesforceConnection
NotFoundException

An error occurs when the external session ID is not used and the Salesforce 
Connection shared resource is not configured correctly.
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Salesforce Query All
Activity

The Salesforce Query All activity performs the specified SOQL SELECT 
statement. 

The Salesforce Query All activity executes a query against the specified object and 
returns data that matches the specified criteria.

Configuration Tab
Table 16 lists and explains the fields in the Configuration tab.

Input Tab
The Input tab contains the Process Data panel and the Activity Input panel. The 
information in the Process Data panel gives an overview of all the processes. The 
Activity Input panel provides the parameters that you can specify or change for 
all activities. Table 17 lists and explains the fields in the Input tab.

Table 16   Salesforce Query All Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

Salesforce 
Connection

Yes Path to the shared configuration resource containing the Salesforce 
connection information. 

Click the Browse button to open the Select a Resource dialog. All 
usable connections are listed in the dialog. Select one to apply to your 
current activity.

Operations No Select a query operation from the Operations drop-down list. The 
default operation is Query. If you select Query from the drop-down 
list, the operation retrieves existing records only. If you select 
QueryAll, the operation retrieves all archived and deleted records.

Table 17   Salesforce Query All Input Tab (Sheet 1 of 4)

Input Items Data 
Type Description

connectionInfo (All fields in this section are optional.)
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serverUrl String URL of the endpoint that is used by this operation.

sessionId String Unique ID associated with this session.

externalSessionIdUsed Boolean Specifies whether an external session ID is used (true) or 
not (false).

If the value is set to true, an external session ID is filled in 
the sessionId field.

When the session has to be refreshed, the refresh operation 
cannot be performed, and an exception is thrown. 

query/queryAll

batchSize Integer Optional. When processing large amounts of data, the 
activity internally invokes several SOAP calls. This field is 
used to set the batch size for the number of records returned 
through a SOAP call.

The value ranges from 200 to 2000:

• If the input value equals -1, it is set to the default 
value.

• If the input value is greater than 2000, it is set to 
2000.

• If the input value is less than 200 (except -1), it is 
set to 200. 

• The default value is 500.

queryMain

queryString String Required. A query string follows the SOQL syntax. The 
queryString field specifies the object to query, the fields to 
return, and any condition for including a specific object in 
the query.

query_Optional (All fields in this section are optional.)

_configData

Table 17   Salesforce Query All Input Tab (Sheet 2 of 4)

Input Items Data 
Type Description
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timeout Integer The timeout value specifies the number of milliseconds an 
internal API call waits before the data is returned. 

The default value is 15000 milliseconds. 

You can also change the default timeout value by setting the 
properties. See Default Timeout Value Setting on page 103 
for detailed information.

headers

MruHeader

updateMru Boolean Specifies whether to update the list of most recently used 
items (true) or not (false), which is on the sidebar in the 
Salesforce.com user interface.

PackageVersionHeader

PackageVersion

majorNumber Integer The major version number of a package version. 

A package version is denoted by majorNumber.minorNumber, 
for example 2.1.

minorNumber Integer The minor version number of a package version. 

A package version is denoted by majorNumber.minorNumber, 
for example 2.1.

namespace String The unique namespace of the managed package.

CallOptions

client String A string that identifies a particular client.

defaultName
space

String A string that identifies a developer namespace prefix. Use 
this field to resolve field names in managed packages 
without having to fully specify the fieldName everywhere.

Table 17   Salesforce Query All Input Tab (Sheet 3 of 4)

Input Items Data 
Type Description
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Guidelines for Retrieving Data in Subset Mode

When the result set of a query is very large, you can retrieve subsets of the result 
set and iterate until the entire result set is processed. To retrieve subsets, you must 
use a Repeat Until True loop group to iterate through the entire result set. 

1. Create a Salesforce Query All activity. 

2. Specify the fields in the Configuration tab and create a query that returns 
multiple rows.

3. Set the value of the ProcessInSubsets field to true in the Input tab. 

4. Set the subsetSize field to the maximum number of messages of batch size you 
want to process for each execution loop. 

SubsetSetting

ProcessInSubsets Boolean Optional. Specifies whether you can process smaller batches 
of rows instead of retrieving one large result set (true) or 
not (false). 

This element must be used in conjunction with a Repeat 
Until True loop group for processing the result sets. See 
Guidelines for Retrieving Data in Subset Mode on page 37 
for more information. 

The default value is false. 

subsetSize Integer Optional. This element is available only when the 
ProcessInSubsets field is set to true. When that field is set 
to true, records are processed in batches and the returned 
data will be passed out from the activity when completing 
the activity in a subsetSize batch. 

This element specifies the maximum number of messages 
that are picked up for each execution loop. The value ranges 
from 1 to 10. 

By setting the subsetSize field, you can process smaller 
batches of rows instead of retrieving one large result set. This 
element must be used in conjunction with a Repeat Until 
True loop group for processing the result sets. See 
Guidelines for Retrieving Data in Subset Mode on page 37 
for more information. 

The default value is 1. 

Table 17   Salesforce Query All Input Tab (Sheet 4 of 4)

Input Items Data 
Type Description
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5. Select the Salesforce Query All activity, and then click the Create a group icon 
 on the tool bar to create a group containing this activity. See TIBCO 

BusinessWorks Process Design Guide for more information about working with 
groups. 

6. Select Repeat-Until-True from the Group Action list, and specify an index 
name, for example, i. 

7. The loop exits when the entire result set has been consumed. The condition for 
the loop can be set to the following: 

$Salesforce-Query-All/ns:queryAllOutput/queryAllResponse/lastSu

bset=’true’ 

Figure 8   Configuring the Group 

The previous procedure is a general guideline for creating a loop group to process 
a large set of records. You might want to modify the procedure to include 
additional processing of the records, or you might want to change the XPath 
expressions to suit your business process. 
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Relationship Query

Relationship query can be used to query multiple sObjects at a time in the 
Salesforce.com database. A relationship is created between those sObjects. SOQL 
provides the syntax to support relationship queries. 

Parent-to-children and child-to-parent are the two possible relationships between 
sObjects. In the Salesforce.com database, some sOjects with a relationship are 
predefined. For example, Account is a parent of Contact. You can use 
relationship queries to search for sObjects of one type based on the criteria that 
applies to sObjects of another type. For example, “return all accounts created by 
Bob Jones and the contacts associated with those accounts.” A parent-to-children 
or child-to-parent relationship must be created to connect the sObjects. See 
Figure 9.

Figure 9   Parent-to-children and Child-to-parent Relationships

For more information about relationship queries, See Force.com Web Services API 
Developer's Guide. 

To learn how to do relationship queries in the Salesforce Query All activity, see 
Relationship Query Sample Project on page 78.
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Output Tab
Table 18 lists and explains the fields in the Output tab.

Error Output Tab
Table 19 lists and explains the possible exceptions that can be thrown by this 
activity. 

Table 18   Salesforce Query All Output Tab

Output Item Data Type Description

queryAllResponse

result

done Boolean Indicates whether additional rows have to be retrieved from the 
query results (false) using another query activity, or not (true). 
Your client application can use this value as a loop condition when 
iterating through the query results.

queryLocator String Used in subsequent query activities for retrieving sets of objects from 
the query results, if applicable.

records Complex An array of sObjects representing individual objects of the specified 
object and containing data defined in the field list specified in the 
query string.

Those sObjects can be converted to the specified type defined in the 
metadata schema, for example, the Salesforce_Metadata schema, 
retrieved from the Salesforce.com server.

size Integer Total number of rows retrieved in the query. Your client application 
can use this value to determine whether the query retrieved any rows 
(size>0) or not (size=0).

lastSubset Boolean Indicates whether the current output is the last subset (true) or not 
(false). 

Table 19   Salesforce Query All Error Output Tab

Exception Thrown when 

SalesforceExecuteSOAP
MethodException

An error occurs when a SOAP method is called. 

For example, a wrong value is set in the Input field or the Salesforce 
session times out. 

SalesforceLoginException An error occurs when you logs on to the Salesforce.com server. 
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SalesforceConnection
NotFoundException

An error occurs when the external session ID is not used and the Salesforce 
Connection shared resource is not configured correctly.

Table 19   Salesforce Query All Error Output Tab (Cont’d)

Exception Thrown when 
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Salesforce Retrieve All
Activity

The Salesforce Retrieve All activity retrieves one or more individual objects from 
the data of your organization. This activity is based on the specified object IDs.

Configuration Tab
Table 20 lists and explains the fields in the Configuration tab.

Input Tab
The Input tab contains the Process Data panel and the Activity Input panel. The 
information in the Process Data panel gives an overview of all the processes. The 
Activity Input panel provides the parameters that you can specify or change for 
all activities. Table 21 lists and explains the fields in the Input tab.

Table 20   Salesforce Retrieve All Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

Salesforce 
Connection

Yes Path to the shared configuration resource containing the Salesforce 
connection information. 

Click the Browse button to open the Select a Resource dialog. All 
usable connections are listed in the dialog. Select one to apply to your 
current activity.

Table 21   Salesforce Retrieve All Input Tab (Sheet 1 of 4)

Input Items Data Type Description

connectionInfo (All fields in this section are optional.)

serverUrl String URL of the endpoint that is used by this operation.

sessionId String Unique ID associated with this session.
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externalSessionIdUsed Boolean Specifies whether an external session ID is used (true) or 
not (false).

If the value is set to true, an external session ID is filled in 
the sessionId field.

When the session has to be refreshed, the refresh operation 
cannot be performed, and an exception is thrown. 

retrieve

batchSize Integer Optional. When processing large amounts of data, the 
activity internally invokes several SOAP calls. This field is 
used to set the batch size for the number of records 
returned through a SOAP call.

The value ranges from 200 to 2000: 

• If the input value equals -1, it is set to the default 
value. 

• If the input value is greater than 2000, it is set to 
2000. 

• If the input value is less than 200 (except -1), it is 
set to 200. 

• The default value is 500.

retrieveMain

fieldList String Required. List of one or more fields in the specified object, 
separated by commas.You must specify valid field names 
and must have read-level permissions to each specified 
field.

The fieldList field defines the ordering of fields in the 
result. Because using the wildcard (*) character might 
return a very large result set that can slow client 
application performance, use it only when necessary.

sObjectType String Required. The specified value must be a valid object for 
your organization. 

ids String Required. An array of one or more IDs of the objects to be 
retrieved. You can pass a maximum of 2000 object IDs to 
the activity. 

Table 21   Salesforce Retrieve All Input Tab (Sheet 2 of 4)

Input Items Data Type Description
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retrieve_Optional

_configData

timeout Integer Specifies the number of milliseconds an internal API call 
waits before the data is returned. 

The default value is 15000 milliseconds. 

You can also change the default timeout value by setting 
the properties. See Default Timeout Value Setting on 
page 103 for detailed information.

headers

MruHeader

updateMru Boolean Specifies whether to update the list of most recently used 
items (true) or not (false), which is on the sidebar in the 
Salesforce.com user interface.

PackageVersionHeader

PackageVersion

majorNumber Integer The major version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

minorNumber Integer The minor version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

namespace String The unique namespace of the managed package.

CallOptions

client String A string that identifies a particular client.

defaultName
space

String A string that identifies a developer namespace prefix. Use 
this field to resolve field names in managed packages 
without having to fully specify the fieldName everywhere.

Table 21   Salesforce Retrieve All Input Tab (Sheet 3 of 4)

Input Items Data Type Description
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Guidelines for Retrieving Data in Subset Mode 

When the result set of a retrieve operation is very large, the result can be returned 
in subsets and iterate until the entire result set is processed. To retrieve subsets, 
you must use a Repeat Until True loop group to iterate through the entire result 
set. 

1. Create a Salesforce Retrieve All activity. 

2. Specify the fields in the Configuration tab and create a retrieve operation that 
returns multiple rows.

3. Set the value of the ProcessInSubsets field to true in the Input tab. 

4. Set the value of the subsetSize field to the maximum number of messages of 
batch size you want to process for each execution loop. 

SubsetSetting

ProcessInSubsets Boolean Optional. Specifies whether you can process smaller 
batches of rows instead of retrieving one large result set 
(true) or not (false). 

This element must be used in conjunction with a Repeat 
Until True loop group for processing the result sets. See 
Guidelines for Retrieving Data in Subset Mode on page 45 
for more information. 

The default value is false. 

subsetSize Integer Optional. This element is available only when the 
ProcessInSubsets field is set to be true. When that field is 
set to be true, records are processed in batches and the 
returned data will be passed out from the activity when 
completing the activity in a subsetSize batches. 

This element specifies the maximum number of messages 
that are picked up for each execution loop. Its range is from 
1 to 10. 

By setting the subsetSize field, you can process smaller 
batches of rows instead of retrieving one large result set. 
This element must be used in conjunction with a Repeat 
Until True loop group for processing the result sets. See 
Guidelines for Retrieving Data in Subset Mode on page 45 
for more information. 

The default value is 1. 

Table 21   Salesforce Retrieve All Input Tab (Sheet 4 of 4)

Input Items Data Type Description
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5. Select the Salesforce Retrieve All activity, and then click the Create a group 
icon  on the tool bar to create a group containing this activity. See TIBCO 
BusinessWorks Process Design Guide for more information about working with 
groups. 

6. Select Repeat-Until-True from the Group Action list, and specify an index 
name, for example, i. See Figure 8 on page 38.

7. The loop exits when the entire result set has been consumed. The condition for 
the loop can be set to the following: 

$Salesforce-Retrieve-All/ns:retrieveAllOutput/retrieveAllRespon

se/lastSubset=’true’ 

The previous procedure is a general guideline for creating a loop group to process 
a large set of records. You might want to modify the procedure to include 
additional processing of the records, or you might want to change the XPath 
expressions to suit your business process. 

Output Tab
Table 22 lists and explains the fields in the Output tab.

Error Output Tab
Table 23 lists and explains the possible exceptions that can be thrown by this 
activity. 

Table 22   Salesforce Retrieve All Output Tab

Output Item Data Type Description

retrieveAllResponse

result Complex An array of sObjects representing individual objects of the 
specified object and containing data defined in the field list 
specified in the IDs.

Those sObjects can be converted to the specified type defined in 
the metadata schema, for example, the Salesforce_metadata 
schema, retrieved from the Salesforce.com server.

lastSubset Boolean Indicates whether the current output is the last subset (true) or 
not (false). 
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Table 23   Salesforce Retrieve All Error Output Tab

Exception Thrown when 

SalesforceExecuteSOAP
MethodException

An error occurs when a SOAP method is called. 

For example, a wrong value is set in the Input field or the Salesforce session 
times out.

SalesforceLoginException An error occurs when you logs on to the Salesforce.com server. 

SalesforceConnection
NotFoundException

An error occurs when the external session ID is not used and the Salesforce 
Connection shared resource is not configured correctly.
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Salesforce Update All
Activity

The Salesforce Update All activity updates one or more existing objects with the 
data of your organization.

Configuration Tab
Table 24 lists and explains the fields in the Configuration tab.

Input Tab
The Input tab contains the Process Data panel and the Activity Input panel. The 
information in the Process Data panel gives an overview of all the processes. The 
Activity Input panel provides the parameters that you can specify or change for 
all activities. Table 25 lists and explains the fields in the Input tab.

Table 24   Salesforce Update All Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

Salesforce 
Connection

Yes Path to the shared configuration resource containing the Salesforce 
connection information. 

Click the Browse button to open the Select a Resource dialog. All usable 
connections are listed in the dialog. Select one to apply to your current 
activity.

Table 25   Salesforce Update All Input Tab (Sheet 1 of 6)

Input Items Data Type Description

connectionInfo (All fields in this section are optional.)

serverUrl String URL of the endpoint that is used by this operation.

sessionId String Unique ID associated with this session.
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externalSessionIdUsed Boolean Specifies whether an external session ID is used (true) or 
not (false).

If the value is set to true, an external session ID is filled in 
the sessionId field.

When the session has to be refreshed, the refresh operation 
cannot be performed, and an exception is thrown. 

update

batchSize Integer Optional. When processing large amounts of data, the 
activity internally invokes several SOAP calls. This field is 
used to set the batch size for the number of records updated 
through a SOAP call.

The value ranges from 1 to 200:

• If the input value equals to -1, it is set to the default 
value. 

• If the input value is greater than 200, it is set to 200. 

• If the input value is less than 1 (except -1), it is set 
to 1. 

• The default value is 200.

updateSObjects

sObjects Complex Required. An array of one or more objects to be updated. 
This sObject can be converted to the specified type defined in 
the metadata schema, for example, the Salesforce_Metadata 
schema, retrieved from the Salesforce.com server.

To create a new relationship between a newly created sObject 
(sObject A) and an existing sObject (sObject B), where the 
sObject A schema includes the sObject B schema, set the 
value of the key field in sObject B while updating sObject A. 
If you modify the values of the fields in sObject B within the 
sObject A schema, the original sObject B is not modified. The 
key field in sObject B within the sObject A schema is only 
used to link sObject A with the original sObject B. 

Note: In this release, you can create up to 10 object types in 
one call. Click type > Statement > Duplicate to add multiple 
object types. See Figure 7 on page 24.

update_Optional

Table 25   Salesforce Update All Input Tab (Sheet 2 of 6)

Input Items Data Type Description
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_configData

timeout Integer Specifies the number of milliseconds an internal API call 
waits before the data is returned. The default value is 15000 
milliseconds. 

You can also change the default timeout value by setting the 
properties. See Default Timeout Value Setting on page 103 
for detailed information.

Table 25   Salesforce Update All Input Tab (Sheet 3 of 6)

Input Items Data Type Description
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headers

DebuggingHeader

debugLevel String Specifies the level of detail in the debug header. See Apex 
Developer’s Guide for detailed information. 

The response of the debugging information can be found in 
the SOAP message log. You might have to enable the debug 
role log for tracing the debugging errors. 

MruHeader

updateMru Boolean Specifies whether to update the list of most recently used 
items (true) or not (false), which is on the sidebar in the 
Salesforce.com user interface.

EmailHeader

triggerAuto
ResponseEmail

Boolean Specifies whether to trigger auto-response rules (true) or 
not (false), for leads and cases. In the Salesforce.com user 
interface, this email can be automatically triggered by a 
number of events, for example, resetting an user password.

triggerOtherEmail Boolean Specifies whether to trigger an email outside the 
organization (true) or not (false). In the Salesforce.com 
user interface, this email can be automatically triggered by 
creating, editing, or deleting a contact for a case.

triggerUserEmail Boolean Specifies whether to send an auto-response email to the 
owner specified in the owner ID (true) or not (false).

AllowFieldTruncationHeader

allowFieldTruncation Boolean Specifies whether to truncate field values that are too long 
(true) or not (false). 

The default value is false: no change in behavior. If a string 
or text area value is too large, the operation fails and the error 
code STRING_TOO_LONG is returned.

Table 25   Salesforce Update All Input Tab (Sheet 4 of 6)

Input Items Data Type Description
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PackageVersionHeader

PackageVersion

majorNumber Integer The major version number of a package version. 

A package version is denoted by majorNumber.minorNumber, 
for example 2.1.

minorNumber Integer The minor version number of a package version. 

A package version is denoted by majorNumber.minorNumber, 
for example 2.1.

namespace String The unique namespace of the managed package.

AssignmentRuleHeader

assignmentRuleId String ID of a specific assignment rule to run for Case or Lead. It can 
be an inactive assignment rule. The ID can be retrieved by 
querying the AssignmentRule object. If this field is specified, 
set the value in the useDefaultRule field to false. This 
element is ignored for Account, because all territory 
assignment rules are applied.

Case and Lead are two predefined Salesforce.com schema 
types. For more information about these two types, see 
Force.com Web Service API Developer's Guide. 

useDefaultRule Boolean If the value of the useDefaultRule field is set to true for 
Case or Lead, the default (active) assignment rule for Case or 
Lead is used. If this field is specified, do not specify an 
assignmentRuleId and type an empty string in the 
assignmentRuleId field. If the value of the useDefaultRule 
field is set to true for Account, all territory assignment rules 
are applied; if the value is set to false, no territory 
assignment rules are applied.

CallOptions

client String A string that identifies a particular client.

defaultNamespace String A string that identifies a developer namespace prefix. Use 
this field to resolve field names in managed packages 
without having to fully specify the fieldName everywhere.

Table 25   Salesforce Update All Input Tab (Sheet 5 of 6)

Input Items Data Type Description
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AllOrNoneHeader

allOrNone Boolean If the value of the allOrNone field is set to true, any failed 
records in a call cause all changes for the call to be rolled 
back. Record changes are not committed unless all records 
are processed successfully.

The default value is false. Some records can be processed 
successfully although others are marked as failed in the call 
results.

Note: When processing large amounts of data, the activity 
internally invokes several SOAP calls. However, this 
AllOrNoneHeader only applies to each internal SOAP call. 
If the value of the allOrNone field is set to true, the records 
in each internal SOAP call will all succeed or be rolled back.

DisableFeedTrackingHeader

disableFeedTracking Boolean If the value of this item is set to true, the changes made in 
the current call are not tracked in feeds.

The default value is false.

StreamingEnabledHeader

streamingEnabled Boolean Specifies whether you want to receive streaming notifications 
for changes to Salesforce data.

OwnerChangeOptions

transferAttachments Boolean If the value of this field is set to true, the record’s, 
attachments are transferred to the new record owner. If the 
value is set to false, the original record owner retains 
ownership.The default is false.

transferOpenActivities Boolean If the value of this field is set to true, the open activities of 
the record are transferred to the new record owner. If the 
value is set to false, the original record owner retains the 
ownership. The default is false.

Table 25   Salesforce Update All Input Tab (Sheet 6 of 6)

Input Items Data Type Description
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Output Tab
Table 26 lists and explains the fields in the Output tab.

Error Output Tab
Table 27 lists and explains the possible exceptions that can be thrown by this 
activity. 

Table 26   Salesforce Update All Output Tab

Output Item Data Type Description

updateAllResponse

result

errors Complex If errors occur during the activity, an array of Error objects with the 
error code and description, is returned.

id String ID of an sObject that you attempted to create. 

success Boolean Indicates whether the create activity succeeded (true) or not 
(false).

Table 27   Salesforce Update All Error Output Tab

Exception Thrown when 

SalesforceExecuteSOAP
MethodException

An error occurs when a SOAP method is called. 

For example, a wrong value is set in the Input field or the Salesforce session 
times out. 

SalesforceLoginException An error occurs when you logs on to the Salesforce.com server. 

SalesforceConnection
NotFoundException

An error occurs when the external session ID is not used and the Salesforce 
Connection shared resource is not configured correctly.
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Salesforce Upsert All
Activity

The Salesforce Upsert All activity creates new objects and updates existing 
objects; uses a custom field to determine the presence of existing objects. 

This activity uses the external ID to determine whether it creates a new object or 
updates an existing one:

• If the external ID is not matched, a new object is created.

• If the external ID is matched once, the existing object is updated.

• If the external ID is matched multiple times, an error is reported.

• When the Salesforce Upsert All activity batches updating multiple objects 
where the external ID is the same for two or more objects in your batch call, 
those records are marked as errors in the UpsertResult. The objects will be 
neither created or updated.

Configuration Tab
Table 28 lists and explains the fields in the Configuration tab.

Table 28   Salesforce Upsert All Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

Salesforce 
Connection

Yes Path to the shared configuration resource containing the Salesforce 
connection information. 

Click the Browse button to open the Select a Resource dialog. All 
usable connections are listed in the dialog. Select one to apply to your 
current activity.
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Input Tab
The Input tab contains the Process Data panel and the Activity Input panel. The 
information in the Process Data panel gives an overview of all the processes. The 
Activity Input panel provides the parameters that you can specify or change for 
all activities. Table 29 lists and explains the fields in the Input tab.

Table 29   Salesforce Upsert All Input Tab (Sheet 1 of 5)

Input Items Data Type Description

connectionInfo (All fields in this section are optional.)

serverUrl String URL of the endpoint that is used by this operation.

sessionId String Unique ID associated with this session.

externalSessionIdUsed Boolean Specifies whether an external session ID is used (true) 
or not (false).

If the value is set to true, an external session ID is filled 
in the sessionId field.

When the session has to be refreshed, the refresh 
operation cannot be performed, and an exception is 
thrown. 

upsert

batchSize Integer Optional. When processing large amounts of data, the 
activity internally invokes several SOAP calls. This field 
is used to set the batch size for the number of records 
created through a SOAP call.

The value ranges from 1 and 200:

• If the input value equals to -1, it will be set to 
the default value. 

• If the input value is greater than 200, it will be 
set to 200. 

• If the input value is less than 1 (except -1), it 
will be set to 1. 

• The default is 200.
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upsertSObjects

externalIDFieldName String Required. This field contains the name of the field 
defined as a key field in the sObject.

sObjects Complex Required. An array of one or more objects to be created 
or updated. This sObject can be converted to the 
specified type defined in the metadata schema, for 
example, the Salesforce_metadata schema, retrieved 
from the Salesforce.com server. 

Note: You do not have to specify the Id field in the 
sObject. 

To create a new relationship between a newly created 
sObject (sObject A) and an existing sObject (sObject B), 
where the sObject A schema includes the sObject B 
schema, set the value of the key field in sObject B while 
upserting sObject A. If you modify the values of the 
fields in sObject B within the sObject A schema, the 
original sObject B is not modified. The key field in 
sObject B within the sObject A schema is only used to 
link sObject A with the original sObject B. 

upsert_Optional (All fields in this section are optional.)

_configData

timeout Integer The timeout value specifies the number of milliseconds 
an internal API call waits before the data is returned. 

The default value is 15000 milliseconds. 

You can also change the default timeout value by setting 
the properties. See Default Timeout Value Setting on 
page 103 for detailed information.

headers

Table 29   Salesforce Upsert All Input Tab (Sheet 2 of 5)

Input Items Data Type Description
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DebuggingHeader

debugLevel String Specifies the level of detail in the debug header. See Apex 
Developer’s Guide for detailed information. 

The response of the debugging information can be found 
in the SOAP message log. You might have to enable the 
debug role log for tracing the debugging errors. 

MruHeader

updateMru Boolean Specifies whether to update the list of most recently used 
items (true) or not (false), which is on the sidebar in 
the Salesforce.com user interface.

AllowFieldTruncationHeader

allowFieldTruncation Boolean Specifies whether to truncate field values that are too 
long (true) or not (false). 

The default value is false: no change in behavior. If a 
string or text area value is too large, the operation fails 
and the error code STRING_TOO_LONG is returned.

PackageVersionHeader

PackageVersion

majorNumber Integer The major version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

minorNumber Integer The minor version number of a package version. 

A package version is denoted by 
majorNumber.minorNumber, for example 2.1.

namespace String The unique namespace of the managed package.

Table 29   Salesforce Upsert All Input Tab (Sheet 3 of 5)

Input Items Data Type Description
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EmailHeader

triggerAuto
ResponseEmail

Boolean Specifies whether to trigger auto-response rules (true) 
or not (false), for leads and cases. In the Salesforce.com 
user interface, this email can be automatically triggered 
by a number of events, for example, resetting a user 
password.

triggerOtherEmail Boolean Specifies whether to trigger an email outside the 
organization (true) or not (false). In the 
Salesforce.com user interface, this email can be 
automatically triggered by creating, editing, or deleting a 
contact for a case.

triggerUserEmail Boolean Specifies whether to send an auto-response email to the 
owner specified in the owner ID (true) or not (false).

AssignmentRuleHeader

assignmentRuleId String ID of a specific assignment rule to run for Case or Lead. It 
can be an inactive assignment rule. The ID can be 
retrieved by querying the AssignmentRule object. If this 
field is specified, set the value in the useDefaultRule 
field to false. This element is ignored for Account, 
because all territory assignment rules are applied.

Case and Lead are two predefined Salesforce.com 
schema types. For more information about these two 
types, see Force.com Web Service API Developer's Guide. 

useDefaultRule Boolean If the value of the useDefaultRule field is set to true for 
Case or Lead, the default (active) assignment rule for 
Case or Lead is used. If this field is specified, do not 
specify an assignmentRuleId and type an empty string in 
the assignmentRuleId field. If the value of the 
useDefaultRule field is set to true for Account, all 
territory assignment rules are applied; if the value is set 
to false, no territory assignment rules are applied.

CallOptions

client String A string that identifies a particular client.

defaultNamespace String A string that identifies a developer namespace prefix. 
Use this field to resolve field names in managed 
packages without having to fully specify the fieldName 
everywhere.

Table 29   Salesforce Upsert All Input Tab (Sheet 4 of 5)

Input Items Data Type Description
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AllOrNoneHeader

allOrNone Boolean If the value of the allOrNone field is set to true, any 
failed records in a call cause all changes for the call to be 
rolled back. Record changes are not committed unless all 
records are processed successfully.

The default value is false. Some records can be 
processed successfully although others are marked as 
failed in the call results.

Note: When processing large amounts of data, the 
activity internally invokes several SOAP calls. However, 
this AllOrNoneHeader only applies to each internal 
SOAP call. If the value of the allOrNone field is set to 
true, the records in each internal SOAP call will all 
succeed or be rolled back.

DisableFeedTrackingHeader

disableFeedTracking Boolean If the value of this field is set to true, the changes made 
in the current call are not tracked in feeds.

The default value is false.

StreamingEnabledHeader

streamingEnabled Boolean Specifies whether you want to receive streaming notifications 
for
changes to Salesforce data.

OwnerChangeOptions

transferAttachments Boolean If the value of this field is set to true, the record’s, 
attachments are transferred to the new record owner. If 
the value is set to false, the original record owner 
retains ownership.The default is false

transferOpenActivities Boolean If the value of this field is set to true, the open activities 
of the record are transferred to the new record owner. If 
the value is set to false, the original record owner 
retains the ownership. The default is false.

Table 29   Salesforce Upsert All Input Tab (Sheet 5 of 5)

Input Items Data Type Description
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Output Tab
Table 30 lists and explains the fields in the Output tab.

Error Output Tab
Table 31 lists and explains the possible exceptions that can be thrown by this 
activity. 

Table 30   Salesforce Upsert All Output Tab

Output Item Data Type Description

upsertAllResponse

result

created Boolean Indicates whether the record is created (true) or updated (false).

errors Complex If errors occurred during the activity, an array of Error objects with the 
error code and description, is returned.

id String ID of an sObject that you attempted to create. 

success Boolean Indicates whether the create activity succeeds (true) or not (false).

Table 31   Salesforce Upsert All Error Output Tab

Exception Thrown when 

SalesforceExecuteSOAP
MethodException

An error occurs when a SOAP method is called. 

For example, a wrong value is set in the Input field or the Salesforce session 
times out. 

SalesforceLoginException An error occurs when you logs on to the Salesforce.com server.

SalesforceConnection
NotFoundException

An error occurs when the external session ID is not used and the Salesforce 
Connection shared resource is not configured correctly.
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Salesforce Outbound Message Listener
Process Starter

The Salesforce Outbound Message Listener process starter creates a process 
instance for incoming salesforce outbound messages. Salesforce Outbound 
Message is part of the workflow rule functionality in salesforce. It uses the 
notifications call to send SOAP messages over HTTP(S) to a designated endpoint 
when triggered by a workflow rule. 

Configuration Tab
Table 32 lists and explains the fields in the Configuration tab.

Table 32   Salesforce Outbound Message Listener Configuration Tab

Field Global Var? Description

Name No The name for the activity in the process definition.

Description No Short description of the activity.

WSDL No Path to the shared configuration resource containing the WSDL 
information. 

Click the Browse button to open the Select a Resource dialog. Select 
one WSDL related to the current Outbound Message Listener to apply 
to your activity.

Keystore File Yes The file to be used for SSL transport. Its data type is JKS format. 

Keystore 
Password

Yes The password to use the Keystore file. 

Requires Client 
Authentication

No Select this check box to enable the client authentication. 

When this check box is selected, the Trusted Certificates Folder option 
becomes enabled so that you can specify a location containing the list 
of trusted certificate authorities. 

Trusted 
Certificates 
Folder

No This field is enabled only when the Requires Client Authentication 
check box is selected. 

This field specifies a folder in the project containing one or more 
certificates from trusted certificate authorities. This folder is checked 
when a client connects to ensure that the client is trusted. This prevents 
connections from rogue clients. 
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Making Authenticated Web Service Callouts Using SSL

Callouts is a powerful feature that you can connect to other web services to 
exchange data. You can use it to notify other services of changes to data in your 
environment or retrieve data from a remote system.

Callouts can be secured using SSL, in which both the client and the server present 
certificates to prove their identities to each other. The following section describes 
two SSL authentications.

• One-way SSL Authentication

• Two-way SSL Authentication

One-way SSL Authentication

For outbound messaging, one-way SSL authentication is enabled by default. Once 
you have defined an outbound message, you have to perform the following steps 
to configure the one-way SSL authentication:

1. Log on to the Salesforce.com server, click App Setup > Workflow & 
Approvals > Outbound Messages from the left panel, and then all outbound 
messages are displayed. 

Note the following conditions about the Salesforce Outbound Message Listener 
activity:

• If a Salesforce Outbound Message Listener activity is used in a process, the 
full path name of the process must be consistent with the one that is displayed 
in the Endpoint URL, which is used to configure the outbound message on the 
Salesforce.com website. 

For example, the Endpoint URL is 
http://192.168.0.1:8443/listengroup/listenprocess, in which 
listengroup is the name of the directory in which the process is defined in a 
TIBCO Designer project, and listenprocess is the name of the process. 

• When using a Salesforce Outbound Message Listener activity with the 
specified WSDL file, the host and port of the Endpoint location are 
hard-coded in the WSDL file. To make configuring the Salesforce Outbound 
Message Listener activity more convenient, set the values to the following two 
global variables:

— salesforce.outbound.host 

— salesforce.outbound.port

After configuring the previous two global variables in TIBCO Administrator, 
you must redeploy the application for the global variables to take effect. 
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2. Click the one you want to use, and then the Workflow Outbound Message 
Detail panel is displayed.

3. Right-click the Click for WSDL link, and then click Save Link As to save the 
WSDL to your local directory.

4. Start TIBCO Designer and click Project > Import Resources from File, Folder, 
URL from the menu. The Import Resource or File dialog is displayed.

5. Select File (.xsd,.xslt,.wsdl,.*) item from the Format list. Click Browse to 
navigate to the directory where you stored the downloaded WSDL file, and 
then click OK.The WSDL file is displayed in the Project panel.

6. Click Salesforce Outbound Message Listener in the Design panel; click 
Browse next to the WSDL field in the Configuration tab; select the WSDL file 
you just imported, and click OK.

7. Specify the Keystore File and the Keystore Password fields in the 
Configuration tab, and then click Apply. 

Two-way SSL Authentication

In two-way SSL authentication, the identities of the client and server are 
represented by digital certificates. Currently, Salesforce supports both self-signed 
and CA-signed certificates. To configure the two-way SSL authentication:

1. Perform step 1 to step 4 in the One-way SSL Authentication section.

2. Select Folder from the Format list. Click Browse to navigate to the directory 
that stores the certificate folder, and click OK. The certificate folder that 
contains the accepted certificates is displayed in the Project panel.

3. Click Salesforce Outbound Message Listener in the Design panel, and select 
the Requires Client Authentication check box. The Trusted Certificates 
Folder field is enabled.

4. Click Browse next to the Trusted Certificates Folder field in the 
Configuration tab, select the certificate folder you just imported, and click 
OK.

Click Apply. 
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Misc Tab
Table 33 lists and explains the fields in the Misc tab:

Table 33   Salesforce Outbound Message Listener Misc Tab

Field Description

Sequencing Key This field contains an XPath expression that specifies which processes must be executed in 
order. Processes with the same sequencing key value are executed sequentially in the order 
the processes were created. 

See TIBCO BusinessWorks Process Design Guide for more information about controlling the 
execution order of process instances and about XPath expressions. 

Customer Id This field contains an XPath expression that specifies a custom ID for the process instance. 
This ID is displayed in the View Service dialog of TIBCO Administrator, and it is also 
available in the $_processContext process variable. 
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Chapter 4 Working with TIBCO ActiveMatrix 
BusinessWorks

This chapter describes the basic steps that are required to configure and run 
TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com in TIBCO 
Designer. 

Topics

• Overview of TIBCO ActiveMatrix BusinessWorks, page 68

• Creating a Project, page 69

• Configuring a Plug-in Instance, page 71

• Deploying a Project, page 73
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Overview of TIBCO ActiveMatrix BusinessWorks

TIBCO ActiveMatrix BusinessWorks is a scalable, extensible, and easy-to-use 
integration platform that you can develop and test integration projects. TIBCO 
ActiveMatrix BusinessWorks includes a graphical user interface, TIBCO Designer, 
to define business processes and an engine that executes the process. TIBCO 
Designer is also used to configure TIBCO ActiveMatrix BusinessWorks Plug-in 
for Salesforce.com instances.

See TIBCO Designer User’s Guide and TIBCO ActiveMatrix BusinessWorks Process 
Design for detailed information on how to configure BusinessWorks processes.

Before starting work, you must ensure that all required software has been 
installed and is operating correctly. For a list of required software, see TIBCO 
ActiveMatrix BusinessWorks Plug-in for Salesforce.com Installation. 
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Creating a Project

The TIBCO Designer GUI is used to configure TIBCO ActiveMatrix 
BusinessWorks Plug-in for Salesforce.com instances. When starting TIBCO 
Designer, you must create or select a project. A project contains the configuration 
files that define options used by a runtime plug-in. 

To create a project, perform the following steps:

1. Start TIBCO Designer by executing the following commands, depending on 
your operating system:

— On Microsoft Windows, click Start > All Programs > TIBCO > 
TIBCO_HOME > TIBCO Designer <version_number> TIBCO Designer.

— On UNIX, on a command line, run 
TIBCO_HOME/designer/version_number/bin/designer

2. Click New empty project. The Save Project dialog is displayed.

Figure 10   Creating a Project

3. Click Browse to save the new created project in the desired location or directly 
type the path in the Project Directory field. 
For example, type C:\projects\SFDC in the Project Directory field. See 
Figure 11. 

Click OK.
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Figure 11   Saving the Project
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Configuring a Plug-in Instance

To configure a plug-in instance, complete the following tasks:

• Selecting a WSDL, page 71

• Creating a Salesforce Connection, page 71

• Creating a Salesforce Process, page 72

• Adding Activities to the Process, page 72

Task A Selecting a WSDL

After creating a new project in TIBCO Designer, you have to select a WSDL for the 
project. 

To select a WSDL for your project, perform the following steps: 

1. Select the project you just created, and then click Tools > Salesforce Tools > 
Select WSDL from the TIBCO Designer menu. The Select WSDL dialog is 
displayed.

2. Select a WSDL you want to work with from the Salesforce WSDL list. The 
default WSDL is Partner WSDL. If you select Other WSDLs from the list, you 
have to locate the corresponding WSDL file in your computer. 

3. Click OK, and the Importing Selected WSDL dialog is displayed. 

a. If you click Yes, the selected WSDL is imported, and the Server URL is 
substituted based on the selected WSDL. 

b. If you click No, only the selected WSDL is imported. 

Task B Creating a Salesforce Connection

Before creating or running a TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com instance, you have to create a salesforce connection in the existing 
project. 

To create a salesforce connection, perform the following steps:

This manual uses the Partner 30.0 WSDL to describe the Salesforce activities. For each 
activity, the fields in the Input, Output, and Error Output tabs are generated from the 
Partner 30.0 WSDL. If you select a WSDL other than this WSDL in a project, the fields in the 
Input, Output, and Error Output tabs might be different from the fields explained in 
Chapter 3, Salesforce Palette. 
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1. Select the project you just created in the Project panel, and then drag the 
Salesforce Connection icon from the Palettes panel to the Design panel.

2. Specify the fields in the Configuration tab, and then click Test Connection to 
verify whether the parameters you specified are correct. See Figure 2, Setting 
Up a Salesforce Connection Successfully, page 10. For more configuration 
information, see Chapter 3, Salesforce Palette. 

Click Apply. 

Task C Creating a Salesforce Process

After creating the salesforce connection, you must create a salesforce process to 
deal with certain workflows. 

To create the salesforce process, perform the following steps:

1. Select the root directory in the Project panel, and then drag a Process 
Definition resource from the Palettes panel to the Design panel. 

2. Specify the relevant fields, and then click Apply to save the configuration. For 
more information, see TIBCO Designer User’s Guide. 

Task D Adding Activities to the Process

To add activities to the process, perform the following steps: 

1. Click the process you just created in the Project panel, and the Start and End 
activities are displayed in the Design panel.

2. Drag one or more activities from the Palettes panel to the Design panel, and 
then click the Create Transition icon  on the tool bar to create the 
transition between each two activities. 

3. Configure each activity in the process. See Chapter 3, Salesforce Palette, on 
page 15 for more information. 

4. Test the process in the Tester panel after adding all required activities in the 
process. See TIBCO ActiveMatrix BusinessWorks Process Design for detailed 
information about using test mode.

When selecting a Partner WSDL for your project, you must fetch the salesforce metadata 
from the Salesforce.com server after creating the salesforce connection. The metadata is 
the key point of the database operations. For more information, see Get Metadata on 
page 9. 
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Deploying a Project

When you are ready to deploy your project, generate an Enterprise Archive file 
(EAR) that contains the information about the plug-in activities and processes to 
deploy. You can upload the archive to TIBCO Administrator to deploy the 
associated application. See TIBCO ActiveMatrix BusinessWorks Administration for 
more information.

To deploy a project, perform the following steps:

1. Select the root directory in the Project panel in TIBCO Designer, and then drag 
the Enterprise Archive icon from the Palettes panel to the Design panel.

2. Specify information in the Configuration tab, and then click Apply.

3. Click Build Archive to create the archive file. 

4. Start TIBCO Administrator and import the EAR file, and then create an 
application related to the project.

5. Deploy the application and start the process.

You can also create an EAR file from Tools > Create Project EAR if you have an 
existing process or plug-in instance.
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Chapter 5 Using the Sample Projects

This chapter describes four sample projects packaged with TIBCO ActiveMatrix 
BusinessWorks Plug-in for Salesforce.com. Working through the sample projects 
helps you understand how TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com operates. 

Topics

• General Sample Project, page 75

• Relationship Query Sample Project, page 78

• Integration Project, page 84

• Working with SOAP Activity Project, page 95

To run the following sample projects smoothly, apply for a new developer edition account 
of Salesforce.com.
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General Sample Project

General Sample Project gives you a quick overview of how to use TIBCO 
ActiveMatrix BusinessWorks Plug-in for Salesforce.com. 

To run this project, perform the following steps:

1. Start TIBCO Designer, and then click New empty project. The Save Project 
dialog is displayed.

2. Click Browse and navigate to the project directory you created and specify a 
name for the project, and then click OK.

3. Click Project > Import Full Project from the menu, and click Browse to 
navigate to the SFDC_HOME\examples\GeneralSample folder. Then select 
the DAT file you want to import and click OK.

4. In the Import-Options dialog, click the Replace existing global variables with 
those in import and Overwrite on name conflict radio buttons, and then click 
Apply.

Figure 12   General Sample Project in TIBCO Designer
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In this project, the following two processes are created.

— RemoveSampleData Process

After running the GeneralSample process, you can run this process to 
remove all the generated data from your Salesforce.com database.

— GeneralSample Process

This process is used to show the general configurations of Salesforce 
activities. Most Salesforce activities are included, such as Salesforce Create 
All, Salesforce Query All, Salesforce Retrieve All, and so on.

5. Test and run the processes in the project.

GeneralSample Process
The GeneralSample process contains all Salesforce activities. 

Figure 13   GeneralSample Process

 Table 34 lists and explains the activities in the process.

Table 34   GeneralSample Activities

Activity Description

Timer Starts the process.

Salesforce Create All Salesforce Create All activity. 

Creates five sample Contact sObjects in your Salesforce.com database. 
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Salesforce Query All Salesforce Query All activity.

Executes a query to retrieve the five sample contact sObjects created by the 
Salesforce Create All activity. 

Salesforce Retrieve All Salesforce Retrieve All activity.

Retrieves the five sample contact sObjects created by the Salesforce Create 
All activity.

Salesforce Update All Salesforce Update All activity.

Updates the information of the five sample contact sObjects.

Salesforce Get Session Salesforce Get Session activity.

Obtains a session from the session pool that is related to the specified 
salesforce connection. This session is used in the following Salesforce Upsert 
All activity.

Salesforce Upsert All Salesforce Upsert All activity.

Upserts the information of the five sample contact sObjects. 

When doing this activity, because ID is defined as the external ID, the five 
sample contact sObjects are updated. 

Salesforce Delete All Salesforce Delete All activity.

Deletes all sample data from your Salesforce.com database.

End Ends the process.

Table 34   GeneralSample Activities

Activity Description
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Relationship Query Sample Project

The RelationshipQuerySample Project shows how to do relationship queries in 
TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com. Two kinds of 
relationship queries are defined by Salesforce.com: parent-to-children and 
child-to-parent. For an introduction to relationship queries, see Relationship 
Query on page 39.

To run this project, perform the following steps:

1. Start TIBCO Designer, and then click New empty project. The Save Project 
dialog is displayed.

2. Click Browse and navigate to the project directory you created. Specify a 
name for the project, and then click OK.

3. Click Project > Import Full Project from the menu, and then click Browse to 
navigate to the SFDC_HOME\examples\RelationshipQuerySample folder. 
Select the DAT file you want to import and click OK.

4. In the Import-Options dialog, click the Replace existing global variables with 
those in import and Overwrite on name conflict radio buttons, and then click 
Apply.
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Figure 14   RelationshipQuerySample Project in TIBCO Designer

In this project, the following four processes are created. 
— CreateSampleData

Before running the RelationshipQuery_ChildToParent process or the 
RelationshipQuery_ParentToChildren process, run this process to 
create sample sObjects with the relationship in your Salesforce.com 
database. 

— RemoveSampleData

After running the RelationshipQuery_ChildToParent process or the 
RelationshipQuery_ParentToChildren process, you can run this 
process to remove all the sample data from your Salesforce.com database.

— RelationshipQuery_ChildToParent

This process shows how to do a child-to-parent relationship query and how 
to map the data to other activities. Detailed information about this process 
is provided in the RelationshipQuery_ChildToParent Process section. 

— RelationshipQuery_ParentToChildren

This process shows how to do a parent-to-children relationship query and 
how to map the data to other activities. Detailed information about this 
process is provided in the RelationshipQuery_ParentToChildren Process 
section.
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5. Configure the salesforce connection by using one of the following methods:

— Change the values of the salesforce.username and 
salesforce.password global variables to your user name and password.

— Change the values in the User Name and Password fields in the 
Configuration tab of Salesforce Connection. 

6. Test and run the processes in the project.

RelationshipQuery_ChildToParent Process
This process shows how to do a child-to-parent relationship query and how to 
map the data to other activities. See Figure 15.

Figure 15   RelationshipQuery_ChildToParent Process

 Table 35 lists and explains the fields in the activities in the process.

If some fields cannot be accessed when running the project, you might have to change the 
Field Accessibility configuration in the Salesforce.com database. 

Table 35   RelationshipQuery_ChildToParent Activities

Activity Description

Timer Starts the process.

ChildToPrarent Query Salesforce Query All activity.

Processes the child-to-parent relationship query. 

The following statement is entered in the queryString field. 
Select Id, FirstName, LastName, Account.Id, Account.Name, 
Account.BillingStreet from Contact where 
Account.Name='TIB_Sample_TIB' and 
Account.BillingStreet='TIB_Sample_TIB'

Map Data Receives the returned data from the ChildToParent Query activity, and then 
maps the data values.

For detailed information, see Map Data in The ChildToParent Process.

End Ends the process.
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Map Data in The ChildToParent Process

Mapper is a general activity defined in TIBCO ActiveMatrix BusinessWorks. It is 
used as the data consumer of the ChildToParent Query activity. 

To map data values in the ChildToParent process, perform the following steps:

1. Click the Map Data activity in the ChildToParent process, and the Map Data 
(Mapper) panel is displayed. 

In the Input tab, you can see the available process data and the expected input 
of the activity. The process data and activity input are represented as schema 
trees. 

2. Coerce the records element that is received from the ChildToParent Query 
activity into the data type of the Contact sObject, and then map the coerced 
records element to the Contacts element in the Activity Input area. 

3. Map other elements to the corresponding elements in the Activity Input area, 
see Figure 16. See TIBCO ActiveMatrix BusinessWorks Process Design for more 
information about mapping and transforming input data. 

Figure 16   Map Data in the ChildToParent Process
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RelationshipQuery_ParentToChildren Process
This process shows how to do a parent-to-children relationship query and how to 
map the data to other activities, see Figure 17. 

Figure 17   RelationshipQuery_ParentToChildren Process

 Table 36 lists and explains the fields in the activities in the process.

Mapping Data in The ParentToChildren Process

Mapper is a general activity defined in TIBCO ActiveMatrix BusinessWorks. It is 
used as the data consumer of the ParentToChildren Query activity. 

To map data values in the ParentToChildren process, perform the following 
steps:

1. Click the Map Data activity in the ParentToChildren process, and the Map 
Data (Mapper) panel is displayed. 

In the Input tab, you can see the available process data and the expected input 
of the activity. The process data and activity input are represented as schema 
trees. 

Table 36   RelationshipQuery_ParentToChildren Activities

Activity Description

Timer Starts the process.

ParentToChildren Query Salesforce Query All activity.

Processes the child-to-parent relationship query.

The following statement is entered in the queryString field. 
Select Id, Name,BillingStreet, (select Id, 
FirstName,LastName from Contacts) from Account a where 
a.Name='TIB_Sample_TIB' and 
a.BillingStreet='TIB_Sample_TIB’

Map Data Receives the returned data from the ParentToChildren Query activity, and 
then maps the data values.

For detailed information, see Mapping Data in The ParentToChildren Process.

End Ends the process.
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2. Coerce the records element that is received from the ParentToChildren Query 
activity into the data type of the Account sObject and then map the coerced 
records element to the Account element in the Activity Input area. 

3. Map other elements to the corresponding elements in the Activity Input area. 
If you want to map a complex element under the coerced element, you have to 
manually set XPath in the corresponding input field, see Figure 18. The XPath 
must be matched with the corresponding schema returned from the query 
process at run time. See TIBCO ActiveMatrix BusinessWorks Process Design for 
more information about mapping and transforming input data.

Figure 18   Mapping a Complex Element
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Integration Project

Acme Inc. is a fictitious company that delivers computer systems and services to 
companies worldwide. Its enterprise sales department uses Salesforce.com CRM 
for Salesforce Automation (SFA), while the back office uses an Oracle-based ERP 
application for order management. Currently the handoff from sales department 
to finance department and fulfillment is a manual process requiring duplicate 
data entry. When orders enter the ERP system, the sales department has little 
visibility into their status. The executive management team of the company wants 
to integrate Salesforce.com CRM with the Oracle ERP system in order to improve 
order fulfillment times, minimize delivery problems that result from data entry 
errors, and provide customer order summary information to sales users.

Two integration scenarios are defined for the integration project to better illustrate 
this sample application:

• Customer Master
The sales department of the company uses Salesforce.com CRM to manage the 
sales process and to monitor the pipeline. Sales users create new account 
records to represent prospects and opportunity records to track deals in 
progress. The account data entered by sales users is not accurate enough to 
satisfy the requirements for the back office fulfillment and finance 
departments, whereas the Oracle ERP data is tightly controlled and well 
maintained. 

• Opportunity to Order 
During the selling process, a salesperson tracks the status of a deal as it moves 
through the sales pipeline using the Salesforce.com opportunity object. When 
a deal closes, a new order must be created in the ERP system to initiate the 
invoicing and shipment processes. The current manual entry process must be 
replaced by an automated data transfer from Salsforce.com into the ERP 
system. 

How to Use Integration Project
This sample application shows how to use a TIBCO ActiveMatrix BusinessWorks 
process to manipulate the TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com service. 

To access the sample application, perform the followings steps:

1. Start TIBCO Designer, and then click New empty project. The Save Project 
dialog is displayed.

2. Click Browse and navigate to the project directory you created. Specify a 
name for the project and then click OK.
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3. Click Project > Import Full Project from the menu, and then click Browse to 
navigate to the SFDC_HOME\examples\IntegrationProject folder. Select 
the DAT file you want to import and then click OK.

4. In the Import-Options dialog, click the Replace existing global variables with 
those in import and Overwrite on name conflict radio buttons, and then click 
Apply. See the section highlighted by the blue rectangle in Figure 19.

Figure 19   IntegrationProject in TIBCO Designer

5. Log on to the Salesforce.com website by using the new account information. 
Make sure that at least one product has been added to the price book, and this 
product has to be added as the line item for an opportunity whose state is 
close won. 

6. Add a customized field named ErpAccountId in the account object on the 
Salesforce.com server.

7. If you want to run the 
SyncOpporunityProcess_UsingOutboundMsgListener process in TIBCO 
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Designer, create an outbound message on the Salesforce.com website. Make 
sure that the Endpoint URL is: http://host:port/fullpath of the target BW process. 
For example, the Endpoint URL is 
http://192.168.0.1:8443/listengroup/listenprocess, in which 
listengroup is the name of the directory in which the process is defined in a 
TIBCO Designer project and listenprocess is the name of the process. 

8. Generate an Outbound Message WSDL and configure the workflow rule to 
trigger the outbound message you just created. 

9. Use the CreateErpObjects.sql file to build Oracle database tables and other 
necessary objects. CreateErpObjects.sql is available from the following 
directory: 
SFDC_HOME\examples

10. Change global variables if necessary in TIBCO Designer. 
- db.username: The user name of the ERP database.
- db.password: The password of the ERP database related to the specified 
user name. 
- salesforce.username: The user name of the Salesforce.com server.
- salesforce.password: The password of the Salesforce.com server related to 
the specified user name. 
- BW_LastPollingTime_File: The location of the file, in which the last polling 
time is recorded. 
- BW_OpportunityStart_Time: The time that the opportunities start to record. 
All opportunities occur before this time is ignored. 

11. Configure the salesforce connection and the JDBC connection. 

12. Test and run the processes in the sample application.

Customer Master
The Customer Master integration requires implementation of two unidirectional 
processes on the TIBCO ActiveMatrix BusinessWorks platform. 

If a Salesforce Outbound Message Listener activity is used in a process, the full path name 
of the process must be consistent with the one displayed in the Endpoint URL, which is 
used to configure the outbound message on the Salesforce.com website. 

To run this sample application, a new user of Salesforce.com creates at least one product as 
the line item for an opportunity with the state of close won. 
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The first process, SyncAccountProcess, copies all accounts ready for promotion 
from the Salesforce.com server to the ERP system, writes back the ERP Account 
ID primary key field to the ErpAccountId field that has been created in the 
Salesforce.com account, and changes the account record type in the 
Salesforce.com server to the read-only Integrated Account type. This process is 
invoked from within the Opportunity to Order process as required.

The second process, UpdateAccountProcess, monitors accounts in the ERP 
system for changes and updates the Salesforce.com account accordingly.

SyncAccountProcess

The SyncAccountProcess process is shown in Figure 20. 

Figure 20   SyncAccountProcess
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 Table 37 lists and explains the activities in the process.

UpdateAccountProcess

The UpdateAccountProcess process is shown in Figure 21. 

Table 37   SyncAccountProcess Activities

Activity Description

Start Starts the process.

Salesforce Retrieve Account Salesforce Retrieve All activity. 

Retrieves a set of Salesforce.com Account sObjects by using the given sObject 
IDs.

Salesforce Account Maps data from the Salesforce.com account to the ERP account.

Erp Check Account Checks whether an account in the ERP_ACCT table with the same name as the 
account obtained from the Salesforce.com server. 

Erp Update Acct Updates the ERP_ACCT table when an account is found in the activity named 
Erp Check Account.

Erp Update Shipping Updates the shipping information in the ERP_ADDR table after executing the 
activity named Erp Update Acct.

Erp Update Billing Updates the billing information in the ERP_ADDR table after executing the 
activity named Erp Update Acct.

Erp Insert Acct Creates an account in the ERP_ACCT table if an account is not found in the 
activity named Erp Check Account.

Erp Get AcctId Obtains the Account ID from the ERP_ACCT table after executing the activity 
named Erp Insert Acct. 

Erp Insert Shipping Creates the shipping information in the ERP_ADDR table when required.

Erp Insert Billing Creates the billing information in the ERP_ADDR table when required.

Salesforce Update Account Salesforce Update All activity.

Updates the ACCT_ID field value of the newly created records in the 
ERP_ACCT table to the ErpAccountId field value in the Salesforce.com 
account.

End Ends the process.
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Figure 21   UpdateAccountProces

Table 38 lists and explains the activities in the process.

Table 38   UpdateAccountProcess Activities

Activity Description

Timer Starts the process.

Erp Query Acct Obtains ERP accounts from the ERP_ACCT and ERP_ADDR tables.

Group Repeats activities in the group. 

Salesforce Get 
Account

Checks whether the ERP account exists in the Salesforce.com account.

Salesforce Create 
Account

If the ERP account does not exist in the Salesforce.com server, this activity creates a new 
account in the Salesforce.com server.

Salesforce Update 
Account

If the ERP account exists in the Salesforce.com server, this activity updates the account 
in the Salesforce.com server.

End Ends the process.
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Opportunity to Order - Polling
When a deal closes successfully, the owner of the Salesforce.com opportunity 
representing that deal changes its state to Closed Won. The Opportunity to 
Order process requires a process to be implemented on the BusinessWorks 
platform that will look for new closed opportunities on a regular basis and create 
a new order in the ERP system each time one is found. If the order account is not 
in the ERP system, the account record has to be migrated from the Salesforce.com 
CRM as well, according to the Customer Master process.

The process named SyncOpportunityProcess_polling takes the previous task 
in hand. Another two processes named GetLastPollingTimeProcess and 
SetLastPollingTimeProcess are called by the 
SyncOpportunityProcess_Polling process. 

GetLastPollingTimeProcess

The GetLastPollingTimeProcess process is shown in Figure 22. 

Figure 22   GetLastPollingTimeProcesss

Table 39 lists and explains the activities in the process.

Table 39   GetLastPollingTimeProcess Activities

Activity Description

Start Starts the process.

Read File Reads the file, in which the polling time is recorded. 

Create File Creates a file to record the polling time if such file does not exist before. 

Write File Adds a lock sign to the file, in which the polling time is recorded. 

End Ends the process.

Returns the last polling time if it can be read from the file. Otherwise, 
returns the global variable BW_OpportunityStart_Time.
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SetLastPollingTimeProcess

The SetLastPollingTimeProcess process is shown in Figure 23. 

Figure 23   SetLastPollingTime Process

Table 40 lists and explains the activities in the process.

SyncOpportunityProcess_Polling

The SyncOpportunityProcess_Polling process is shown in Figure 24. 

Table 40   SetLastPollingTimeProcess Activities

Activity Description

Start Starts the process.

Retrieves an input variable as the current polling time.

Write File Removes the lock sign from the file. 

Writes the current polling time in the file.

End Ends the process.
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Figure 24   SyncOpportunityProcess_Polling

Table 41 lists and explains the activities in the process.

Table 41   SyncOpportunityProcess_Polling Activities

Activity Description

Timer Starts the process.

You can use it to repeat the process. 

Get Last Polling Time Retrieves the last polling time and locks this process. 

Salesforce Query 
OpportunityHistory

Salesforce Query All activity.

Obtains the results of the opportunity history when the following 
conditions are met:
OpportunityHistory.State = ’Close Won’

OpportunityHistory.CreateDate > the last polling time
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Opportunity to Order - Using Outbound Message Listener
This process uses the Salesforce Outbound Message Listener activity to complete 
the same task as the task described in the Opportunity to Order - Polling section. 

The process named SyncOpportunityProcess_UsingOutboundMsgListener 
takes the task in hand. 

SyncOpportunityProcess_UsingOutboundMsgListener

The SyncOpportunityProcess_UsingOutboundMsgListener process is shown 
in Figure 25. 

Assign Current Polling Time Assigns the system date and time as the current polling time.

Salesforce Query Opportunity Salesforce Query All activity.

Obtains the results of the opportunities according to the following 
conditions:
Opportunity.Id in OpportunityHistory(Queried 
before).OpportunityId

Opportunity.HasLineitem = true

Salesforce Query 
OpportunityLineitem

Salesforce Query All activity.

Obtains the results of the opportunity line items.

Set Last Polling Time Sets the current polling time as the last polling time to the file and unlocks 
this process. 

Transition Control Group 

Check Account Calls SyncAccountProcess shown in Figure 20 to check whether the 
account is synchronized between the Salesforce.com server and the ERP 
system.

Erp Update Order Updates the ERP_ORDER table in the ERP system. 

Erp Update Order Line Updates the ERP_ORDERLINE table in the ERP system.

End Ends the process. 

Table 41   SyncOpportunityProcess_Polling Activities (Cont’d)

Activity Description
 TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com User’s Guide



94 | Chapter 5  Using the Sample Projects
Figure 25   SyncOpportunityProcess_UsingOutboundMsgListener

Table 42 lists and explains the activities in the process.

Table 42   SyncOpportunityProcess_UsingOutboundMsgListener Activities

Activity Description

Salesforce Outbound Message 
Listener

Sets an Outbound Message Listener activity.

You can use this activity to create a new job for processing the coming 
outbound message. 

Salesforce Query 
OpportunityLineitem-1

Salesforce Query All activity.

Obtains the results of the opportunity line items.

Transition Control Group 

Check Account Calls the SyncAccount process, as shown in Figure 20, to check whether 
the account is synchronized between the Salesforce.com server and the ERP 
system.

Erp Update Order Updates the ERP_ORDER table in the ERP system. 

Erp Update Order Line Updates the ERP_ORDERLINE table in the ERP system.

End Ends the process. 
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Working with SOAP Activity Project

This sample application shows how to work with the SOAP activity in a TIBCO 
ActiveMatrix BusinessWorks process to manipulate the TIBCO ActiveMatrix 
BusinessWorks Plug-in for Salesforce.com service. 

The sample process in the project updates the phone number in the specified 
Contact records. It searches the Contact records with a specified phone number 
from the Salesforce.com server by using the SOAP activity, and then updates 
those Contact records with the new phone number. 

To access the sample application, perform the followings steps:

1. Start TIBCO Designer, and then click New empty project. The Save Project 
dialog is displayed.

2. Click Browse and navigate to the project directory you created. Specify a 
name for the project and then click OK.

3. Click Project > Import Full Project from the menu, and then click Browse to 
navigate to the SFDC_HOME\examples\WorkWithSoapActivity folder. Select 
the DAT file you want to import and then click OK.

4. In the Import-Options dialog, click the Replace existing global variables with 
those in import and Overwrite on name conflict radio buttons, and then click 
Apply. See the blue rectangle part in Figure 26.
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Figure 26   WorkWithSoapActivity Project in TIBCO Designer

5. Log on to the Salesforce.com website by using the new account information. 
Make sure that at least one Contact record with the phone number 
4159017000 used in the example process has been created. 

6. Change global variables if necessary in TIBCO Designer. 
- salesforce.username: The user name of the Salesforce.com server.
- salesforce.password: The password of the Salesforce.com server related to 
the specified user name. 

7. Configure the Salesforce connection.

8. Test and run the processes in the sample application.

Update Phone Number
You can see the Update Phone Number process in Figure 26. Table 43 lists and 
explains the activities in the process.
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Table 43   Update Phone Number Activities

Activity Description

Start Starts the process.

Salesforce Get Session Obtains an existing session from the session pool that is related to the specified 
Salesforce connection. 

Search For Target Contact Searches the Contact records with the specified search string. This search 
operation has been defined in the Partner WSDL used in this sample project. 

When configuring a SOAP activity in a process, you might have to provide all 
SSL-related certificates. You can import the Certificates folder containing 
the certificates from the SFDC_HOME\templates directory.

Note: For more information about the SSL configuration, see Chapter 16 in 
TIBCO ActiveMatrix BusinessWorks Process Design.

Salesforce Update Phone 
Number

Salesforce Update All activity.

Updates the specified Contact records with the new phone number. 

End Ends the process.
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Chapter 6 Miscellaneous

This chapter describes the property settings, the time zone construction, and other 
miscellaneous topics in TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com.

Topics

• Properties Settings, page 100

• Processing the Time Zone Information, page 109

• Processing 16 Digits Numeric Data, page 110
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Properties Settings

This section explains the following property settings you might have to configure 
for the product, which are set in the configuration file. For more information 
about configuring the properties, see the TIBCO ActiveMatrix BusinessWorks 
Administration documentation.

• Operating a Configuration File, page 100

• Log Status Settings, page 102

• Retrying Function Setting, page 103

• Default Timeout Value Setting, page 103

• Proxy Settings, page 105

Operating a Configuration File
When working with the TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com, you have to configure some properties for the product. Those 
properties are set in the configuration files.

• Change the contents in the configuration file when you configure and test the 
processes in TIBCO Designer. 

The default configuration file, properties.cfg, is available in 
SFDC_HOME\templates

You can use the default configuration file or create your own configuration 
file, and then change the property lines in the configuration file if necessary. 

See Configuration Template of the properties.cfg File on page 130 to obtain the 
template of the default properties.cfg file.

• Change the contents in the TIBCO ActiveMatrix BusinessWorks configuration 
file before building the archive during the deployment. For detailed 
information about setting custom engine properties, see Chapter 8 in TIBCO 
ActiveMatrix BusinessWorks Administration. 

The default configuration file, bwengine.xml, is available in 
BW_HOME\lib\com\tibco\deployment

When deploying the project, modify the definitions for log status settings, retrying 
function Settings, and proxy settings in the bwengine.xml file located in the 
BW_HOME/lib/com/tibco/deployment directory.

For detailed property settings information, see TIBCO ActiveMatrix BusinessWorks 
Administration.
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For contents related to TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com configuration, see Configuration Template of the 
bwengine.xml File on page 131.  

If you do not want to use the default configuration file, you can create your own 
configuration file for TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com.

To operate a configuration file, perform the following steps:

1. Create a configuration file with the extension .cfg. 

2. Copy and modify the property lines from the default configuration file 
properties.cfg to your .cfg file. 

3. Specify a location to save your .cfg file.

4. Start TIBCO Designer, click Tools > Tester > Start from the menu bar when 
testing your process instance in the Tester panel. The Select Processes to Load 
dialog is displayed. 

5. Click Advanced, and the Advanced Test Settings dialog is displayed. See 
Figure 27. 

Type -p File_Location in the Test Engine User Args field to finish the log status 
settings.

Where, File_Location is the full path of the .cfg file specified in step 3.

Figure 27   Advanced Test Settings

During the deployment of the product, if the TIBCO ActiveMatrix BusinessWorks version 
selected here is other than the one you selected during the installation, you have to check 
the contents of the corresponding bwengine.xml file and make changes, if necessary. 

The following comments at the beginning and end of the default bwengine.xml file must 
not be modified:
<!--startBWSalesForcePluginProperties-->

<!--endBWSalesForcePluginProperties-->
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Log Status Settings
Before running TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com, 
you have to write the following lines in your configuration file (.cfg file) to set 
the log status. 
Trace.Info.*=true

Trace.Error.*=true

Trace.Warn.*=true

com.tibco.plugin.salesforce.debug=false

Table 44   Log Parameters

Property Component Description

Trace.Info.* TIBCO 
ActiveMatrix 
BusinessWorks

Whether the general information is 
shown (true) or not (false) when 
running the application.

The default value is true.

Trace.Error.* TIBCO 
ActiveMatrix 
BusinessWorks

Whether the error message is shown 
(true) or not (false) when running the 
application.

The default value is true.

Trace.Warn.* TIBCO 
ActiveMatrix 
BusinessWorks

Whether the warning message is shown 
(true) or not (false) when running the 
application.

The default value is true.

com.tibco.plugin.salesforce.debug TIBCO 
ActiveMatrix 
BusinessWorks 
Plug-in for 
Salesforce.com

Whether the debug information is shown 
(true) or not (false) during running the 
application. 

The default value is false.

Trace.Info.*, Trace.Error.*, and Trace.Warn.* are three general properties in 
TIBCO ActiveMatrix BusinessWorks. They are not added in the default bwengine.xml 
configuration file. If you want to change the log levels, you have to manually add them to 
the file. For more details, see Changing Log Levels in the bwengine.xml File on page 134. 
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Retrying Function Setting
The retrying function is triggered when you retry connecting to the 
Salesforce.com server with the Salesforce Configuration resource in TIBCO 
BusinessWorks Salesforce.com Plug-in. The retrying function is also triggered 
when you retry the actions in the Salesforce activities which are introduced in 
Chapter 3, Salesforce Palette, such as the Salesforce Query All activity, the 
Salesforce Create All activity, and so on. 

When you retry actions in the Salesforce activities, you have to write the 
following two property lines in your configuration file. 
com.tibco.plugin.salesforce.retry.rotationPolicy=2,5,20
com.tibco.plugin.salesforce.retry.rotationNumber=1

Default Timeout Value Setting
When configuring the Salesforce activity used in a process, you have to set the 
timeout value for the activity. The timeout value specifies the number of 
milliseconds an internal API call waits before it is terminated. For example, for a 
Salesforce Query All activity, you have to set the timeout value as shown in 
Figure 28. 

Table 45   Retrying Function Settings

Property Description

com.tibco.plugin.salesforce.
retry.rotationPolicy

This property is used to set a time interval between each two retrying 
operations. It is applied on both Salesforce activities and the 
Salesforce Get Session activity.

The default value in seconds is 2, 5, 20. If using this default value in 
a process, retrying operation will be triggered three times. The 
activity will wait for 2 seconds before the first retrying, 5 seconds 
before the second retrying, and 20 seconds for the third retrying. 

com.tibco.plugin.salesforce.
retry.rotationNumber

The property is used to set how many times the process defined in 
the com.tibco.plugin.salesforce.retry.rotationPolicy 
property will be executed.

com.tibco.plugin.salesforce.
update.continueOnError

This property is used to identify, if the Update or Upsert activities 
should continue processing records when one or more records in a 
batch fail. By default the property is set to true. If you set the 
property to false, no more records will be processed.
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Figure 28   Setting the Timeout Value 

To conveniently configure the timeout value for the Salesforce activities running 
in TIBCO Designer, you can write the following property line in your 
configuration (.cfg) file.
com.tibco.plugin.salesforce.invoke.timeout=15000

You can change the timeout value in the previous line. This value is the default 
timeout value for each Salesforce activity. 

In TIBCO Designer, 

• If the timeout value in your .cfg file is not set, the process retrieves the 
default timeout value from the .cfg file. 

• If the timeout value in your .cfg file is set, it overrides the default timeout 
value written in the .cfg file. 

Table 46   Default Timeout Value Setting

Property Description

com.tibco.plugin.salesfo
rce. invoke.timeout

This property is used to set the default timeout value for Salesforce 
activities. 

The default value in milliseconds is 15000. 
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Proxy Settings 
When using a proxy, you have to operate proxy settings at design time or run 
time. 

Two groups of proxy properties, the Plug-in HTTP proxy properties and the JAVA 
HTTP proxy properties, are provided in TIBCO ActiveMatrix BusinessWorks 
Plug-in for Salesforce.com. 

Proxy Setting at Design Time

At design time, you can set the values for the following proxy settings in the 
TIBCO Designer TRA file that is available in 
TIBCO_HOME\designer\version_number\bin\

Table 47   Proxy Settings

Group Property Description

Plug-in HTTP 
Proxy Properties

java.property.com.tibco.plugin.sa
lesforce.proxyHost

Required. The proxy host name or its IP 
address. 

java.property.com.tibco.plugin.sa
lesforce.proxyPort

Required. The port on which the proxy 
service is listening. 

java.property.com.tibco.plugin.sa
lesforce.proxyUser

Optional. The user name for logging on 
to the proxy server.

java.property.com.tibco.plugin.sa
lesforce.proxyPwd

Optional. The password for logging on 
to the proxy server.

java.property.com.tibco.plugin.sa
lesforce.proxyTimeout

Optional. The timeout value in minutes 
for an HTTP call.

This property is to help avoid long wait 
times when attempting to retry through 
a proxy.
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The Plug-in HTTP proxy properties are newly created. You can choose either the 
Plug-in HTTP proxy properties or the JAVA HTTP proxy properties during the 
design time.

For example, you can set the value for each parameter using the Plug-in HTTP 
proxy properties:
java.property.com.tibco.plugin.salesforce.proxyHost=192.168.0.1

java.property.com.tibco.plugin.salesforce.proxyPort=8080

java.property.com.tibco.plugin.salesforce.proxyUser=username 

java.property.com.tibco.plugin.salesforce.proxyPwd=password

java.property.com.tibco.plugin.salesforce.proxyTimeout=3

If some optional properties are not required for a customer's use case, for 
example, the confidential information is not required for logging on to the proxy 
server, then the related properties are not required to be written in the TRA file.

For example:
java.property.com.tibco.plugin.salesforce.proxyHost=192.168.0.1

java.property.com.tibco.plugin.salesforce.proxyPort=8080

java.property.com.tibco.plugin.salesforce.proxyTimeout=3

JAVA HTTP 
Proxy Properties

java.property.http.proxyHost Required. The proxy host name or its IP 
address. 

java.property.http.proxyPort Required. The port on which the proxy 
service is listening. 

java.property.http.proxyUser Optional. The user name for logging on 
to the proxy server.

java.property.http.proxyPassword Optional. The password for logging on 
to the proxy server.

java.property.http.timeout Optional. The timeout value in minutes 
for an HTTP call.

This property is to help avoid long wait 
times when attempting to retry through 
a proxy.

Table 47   Proxy Settings (Cont’d)

Group Property Description
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Proxy Settings at Run Time

At run time, you can set the values for the proxy settings in the bwengine.xml file 
that is available in BW_HOME\lib\com\tibco\deployment.

The Plug-in HTTP proxy properties are newly created and are the default for the 
runtime proxy settings. The JAVA HTTP proxy properties are commented in the 
default bwengine.xml file. For backward compatibility in standalone, if you want 
to run projects created in the previous Plug-in release version without modifying 
the proxy settings, you can open the JAVA HTTP proxy properties, and comment 
the Plug-in HTTP proxy properties. 

Table 48   Runtime Proxy Settings 

Group Property Description

Plug-in HTTP 
Proxy properties

com.tibco.plugin.salesforce.
proxyHost

Required. The proxy host name or its IP 
address. 

com.tibco.plugin.salesforce.
proxyPort

Required. The port on which the proxy 
service is listening. 

com.tibco.plugin.salesforce.
proxyUser

Optional. The user name for logging on to the 
proxy server.

com.tibco.plugin.salesforce.
proxyPwd

Optional. The password for logging on to the 
proxy server.

com.tibco.plugin.salesforce.
proxyTimeout

Optional. The timeout value in minutes for an 
HTTP call.

This property is to help avoid long wait times 
when attempting to retry through a proxy.

JAVA HTTP Proxy 
properties

java.property.http.proxyHost Required. The proxy host name or its IP 
address. 

java.property.http.proxyPort Required. The port on which the proxy 
service is listening. 

java.property.http.proxyUser Optional. The user name for logging on to the 
proxy server.

java.property.http.proxyPass
word

Optional. The password for logging on to the 
proxy server.

java.property.http.timeout Optional. The timeout value in minutes for an 
HTTP call.

This property is to help avoid long wait times 
when attempting to retry through a proxy.
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In standalone, you can use either the Plug-in HTTP proxy properties or the JAVA 
HTTP proxy properties to deploy projects in TIBCO Administrator. 
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Processing the Time Zone Information

TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com contains three 
data types for defining the date or time data: date, dateTime, and time. Time 
zone information can be added to the dateTime and time data. Table 49 gives 
detailed information.

Table 49   Data Types for The Date or Time Data

Data Type Data Format Example Description

date yyyy-MM-dd 2009-01-31 Greenwich Mean Time (GMT) date.

Note: If you add the time zone 
information in the date data, TIBCO 
ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com accepts it, but the time 
zone portion cannot be processed.

For example, if the date data is 
2009-01-31+08:00, it is truncated to 
2009-01-31.

dateTime yyyy-MM-ddTHH:
mm:ss
or
yyyy-MM-ddTHH:
mm:ssZ

2009-01-31T16:16:16
or 
2009-01-31T16:16:16Z

GMT datetime.

yyyy-MM-ddTHH:
mm:ss+hh:mm
or 
yyyy-MM-ddTHH:
mm:ss-hh:mm

2009-01-31T16:16:16+
08:00 or 
2009-01-31T16:16:16-
08:00

The datetime data with the specified 
time zone.

time HH:mm:ss
or
HH:mm:ssZ

16:16:16
or 
16:16:16Z

GMT time.

HH:mm:ss+hh:mm
or 
HH:mm:ss-hh:mm

16:16:16+08:00 
or 
16:16:16-08:00

The time data with the specified time 
zone.
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Processing 16 Digits Numeric Data

You can input numeric data of a length greater than 16 digits in the Salesforce.com 
database. 

For an application that is written in the JAVA language, data with a length greater 
than 16 digits is defined as the double type and its precision is changed in the 
application. 

TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com is implemented 
using the JAVA language. When data with a length greater than 16 digits is 
processed between the plug-in and the Salesforce.com database, you might 
encounter the following situations:

• If the data is retrieved from the Salesforce.com database, the precision is 
rounded to 16 digits in the plug-in.

Affected Salesforce activities are Salesforce Query All, Salesforce Retrieve All, 
and Salesforce Outbound Message Listener. 

• If the data has to be sent to the Salesforce.com database, the precision is 
rounded to 16 digits before being sent. 

Affected Salesforce activities are Salesforce Create All, Salesforce Update All, 
and Salesforce Upsert All. 
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Appendix A Trace Messages

This appendix lists the trace messages that are logged to a location specified at 
configuration time.

Topics

• Overview of Trace Messages, page 112

• Status Messages, page 113
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Overview of Trace Messages

Trace messages provide information about plug-in activities. The messages are 
logged to the console where the runtime plug-in is started. 

Introduction to Trace Message Roles

The roles of trace messages in TIBCO ActiveMatrix BusinessWorks Plug-in for 
Salesforce.com are shown in Table 50.

Table 50   Trace Message Roles

Role Name Description

Info Indicates normal plug-in operation. No action is necessary. A trace message tagged with 
Info. indicates that a significant processing step is reached and logged for tracking or 
auditing purposes. Only info. messages preceding a tracking identifier are considered 
significant steps.

Warn An abnormal condition is found. Processing continues, but it is good practice for an 
administrator to pay special attention.

Error An unrecoverable error occurs. Depending on the error severity, the plug-in might 
continue with the next operation or stop.

Debug A developer-defined trace message. In normal operating conditions, debug messages do 
not have to be displayed.
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Status Messages

In an environment where multiple applications are used simultaneously, the 
possible status of messages increases as well. This section lists the various 
messages in numerical order.

Resolutions are provided wherever possible for error and warning messages. If no 
resolution is provided here, or if you want additional help, contact TIBCO Support 
at https://support.tibco.com.

Message Role Category Resolution

BW-Salesforce-100001: Cannot find shared Salesforce configuration: %1

errorRole BW-Plugin Check the configuration of the Salesforce 
connection and reconfigure it.

BW-Salesforce-100002: Error occurred while logging in: %1

errorRole BW-Plugin Check whether the network is connected and 
the user name and password are correct. 

BW-Salesforce-100003: FatalException: Failed to execute the operation after retrying [ %1 ] 
time(s)

errorRole BW-Plugin Check the network configuration.

BW-Salesforce-100004: OperationException: Failed to execute the operation. Please check the 
input configuration. %1 Detailed information: [ %2 ] Other information: [ %3 ]

errorRole BW-Plugin Check the input configuration.

BW-Salesforce-100005: FatalException: Failed to renew the session in %1 activity

errorRole BW-Plugin Check the input of the salesforceConnection 
field.

BW-Salesforce-100006: Exception occurred while executing the operation. Exception type: [ %1 ] 
Exception message:  [ %2 ] Exception detail: [ %3 ] Other information: [ %4 ]

errorRole BW-Plugin

BW-Salesforce-100007: Network problem occurred. The server is currently unavailable or the 
session has timed out
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errorRole BW-Plugin Check the network configuration.

BW-Salesforce-100008: The [ %1 ] operation is temporarily unavailable

errorRole BW-Plugin Contact Salesforce.com support.

BW-Salesforce-100009: Unrecoverable error occurred while executing the [ %1 ] operation

errorRole BW-Plugin Check the input configuration of the activity.

BW-Salesforce-100010: Unrecoverable error occurred while inputting the invalid data for the [ 
%1 ] activity. Please check the input configuration of the activity

errorRole BW-Plugin Check the input configuration of the activity.

BW-Salesforce-100011: ConnectionException: Failed to execute the operation

errorRole BW-Plugin Check the network configuration.

BW-Salesforce-100012: The detailed information about this unknown exception: StackTrace: { 
%1 } Exception Message: [ %2 ]. FullClass [ %3 ]

errorRole BW-Plugin Check the input configuration of the activity or 
contact TIBCO support. 

BW-Salesforce-100013: Data was not returned in limited operation time while executing [ %1 ] 
operation

errorRole BW-Plugin Change the timeout value or check the 
connection of the network.

BW-Salesforce-100014: Application exception occurred while handling an error

errorRole BW-Plugin Check the input configuration of the activity or 
contact TIBCO support.

BW-Salesforce-100015: FatalException: Invalid session error occurred. Since an external seesion 
ID was used, the refreshing session mechanism cannot be performed. The external session ID is 
[ %1 ]

errorRole BW-Plugin Make sure the external session ID is valid.

BW-Salesforce-100016: ApplicationException: The operation failed. %1 Detailed information: [ 
%2 ]. Other information: [ %3 ]

Message Role Category Resolution (Cont’d)
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errorRole BW-Plugin Check the input configuration of the activity or 
contact TIBCO support.

BW-Salesforce-100017: UnknownException: The operation failed. %1

errorRole BW-Plugin Check the input configuration of the activity or 
contact TIBCO support. 

BW-Salesforce-100018: ConnectionException: The operation was failed %1 Detailed 
information: [ %2 ] Other information: [ %3 ]

errorRole BW-Plugin Check the network connection. 

BW-Salesforce-100019: TimeoutException: The timeout value is [ %1 ]. Exception Message: [ %2 ]

errorRole BW-Plugin Change the timeout value or check the 
connection of the network.

BW-Salesforce-100020: The provided certification is invalid or the selected encryption strength 
may not match your policy file

errorRole BW-Plugin Make sure the Salesforce Resources folder 
has been imported and Java Cryptography 
Extension (JCE) has been installed.

BW-Salesforce-100021: ApplicationException: the required field [ %1 ] is empty, please assign a 
valid value

errorRole BW-Plugin Make sure that a valid value is assigned in the 
required field.

BW-Salesforce-100022: OperationException: The returned sObject contained an error. 
statusCode: [ %1 ] message: [ %2 ] sObject ID in the returned data: [ %3 ] fields: [ %4 ] the sObject 
ID in the input: [ %5 ]

errorRole BW-Plugin Check the input configuration of sObjects.

BW-Salesforce-100023: The operation can not be continued because some unrecoverable errors 
occurred. statusCode: [ %1 ] message: [ %2 ] Please check the error message that was generated 
from the activity output

errorRole BW-Plugin Check the error message that was generated 
from the activity output.

Message Role Category Resolution (Cont’d)
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BW-Salesforce-100024: OperationException: The returned sObject contains an error . statusCode: 
[ %1 ] message: [ %2 ] sObject ID in the returned data: [ %3 ] fields: [ %4 ]

errorRole BW-Plugin Check the input configuration of sObjects.

BW-Salesforce-100025: OperationException: the returned sObject has an error. statusCode: [ %1 
]. message: [ %2 ]. sObject id in the returned data: [ %3 ]. fields: [ %4 ]. value assigned for 
externalIDFieldName: [ %5 ]

errorRole BW-Plugin Check the input configuration of sObjects.

BW-Salesforce-100026: Error occurred while executing the Salesforce SOAP method: The 
method is [ %1 ], details - [ %2 ]

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100027: Could not find the WSDL file. Please select Tools -> Salesforce WSDL to 
import the WSDL file

errorRole BW-Plugin Click Tools > Salesforce WSDL to import a 
desired WSDL file.

BW-Salesforce-100028: Failed to retry the operation [ %1 ]

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100029: Failed to retry the operation in a rotation

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100030: Unrecoverable errors returned with the records. Please find the 
information of the related records in the log

errorRole BW-Plugin Check the input configuration of the activity.

BW-Salesforce-100031: The required field 'externaIIdFieldName' was empty. Could not do 
retrying for the Create All

errorRole BW-Plugin Fill in the value in the externalIdFieldName 
field.

BW-Salesforce-100032: Failed to retry the operation for all [ %1 ] rotation(s)

errorRole BW-Plugin Check the input configuration of the activity.

Message Role Category Resolution (Cont’d)
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BW-Salesforce-100033: Error was kept in the returned sObject. The index number in the batch: [ 
%1 ], statusCode: [ %2 ], message: [ %3 ], sObject ID in the returned data (if available): [ %4 ], 
fields (if available): [ %5 ]

errorRole BW-Plugin Check the error message that was generated 
from the activity output.

BW-Salesforce-100034: Error occurred on the Outbound Message Listener: [ %1 ]

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100035: Unrecoverable error was kept in the returned sObject. The index number 
in the batch: [ %1 ], statusCode: [ %2 ], message: [ %3 ], sObject ID in the returned data (if 
available): [ %4 ], fields (if available): [ %5 ]

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100036: Recoverable error was kept in the returned sObject. The index number in 
the batch: [ %1 ], statusCode: [ %2 ], message: [ %3 ], sObject ID in the returned data (if available): 
[ %4 ], fields (if available): [ %5 ]

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100037: Common error was kept in the returned sObject. The index number in 
the batch: [ %1 ], statusCode: [ %2 ], message: [ %3 ], sObject ID in the returned data (if available): 
[ %4 ], fields (if available): [ %5 ]

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100038: The operation failed. Error message: [ %1 ]

errorRole BW-Plugin Check the input configuration of the activity. 

BW-Salesforce-100039: Could not find an available session for the operation [ %1 ]. Please check 
the configuration of the Salesforce Connection

errorRole BW-Plugin Check the configuration of the Salesforce 
connection.

BW-Salesforce-100040: The WSDL was NOT specified

errorRole BW-Plugin Configure an Outbound Message WSDL 
generated from the Salesforce.com server.

BW-Salesforce-100041: The Keystore File was NOT specified

Message Role Category Resolution (Cont’d)
 TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com User’s Guide



118 | Appendix A  Trace Messages
errorRole BW-Plugin Configure a Keystore file.

BW-Salesforce-100042: The Trusted Certificates Folder was NOT specified

errorRole BW-Plugin Configure a Trusted Certificates folder.

BW-Salesforce-100043: Cannot find any leaf certificate in the specified Trusted Certificates 
Folder [ %1 ]

errorRole BW-Plugin Add the leaf certificate into the certificates 
folder to compose a trusted certificate chain.

BW-Salesforce-100044: Cannot authenticate the client. Please check the configured trusted 
certificates

errorRole BW-Plugin Check the configured trusted certificates.

BW-Salesforce-100045: No leaf certificate available in the incoming HTTP message

errorRole BW-Plugin Make sure that the leaf certificate has been 
added.

BW-Salesforce-100046: No leaf certificate CN generated during design-time for Client 
Authentication

errorRole BW-Plugin Make sure that the leaf certificate in the Trusted 
Certificates folder is available.

BW-Salesforce-100047: No CN available in the incoming HTTP message

errorRole BW-Plugin Make sure the leaf certificate is available.

BW-Salesforce-100048: Client Authentication failed. The following CN(s) is/are generated from 
the design-time configured leaf certificates: [ %1 ]. The follow CN(s) is/are generated from the 
incoming HTTP message: [ %2 ] 

errorRole BW-Plugin Make sure that the leaf certificate provided is 
correct.

BW-Salesforce-100049: No ContentType is defined in the incoming HTTP message, so the 
message cannot be processed for Client Authentication

errorRole BW-Plugin

BW-Salesforce-100050: The incoming HTTP message is invalid for Client Authentication

Message Role Category Resolution (Cont’d)
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errorRole BW-Plugin

BW-Salesforce-100051: The defined process name [ %1 ] is not consistent with the one set in the 
WSDL. The full address defined in the WSDL is [ %2 ]

errorRole BW-Plugin Make sure that the path of the process is 
consistent with the path that is displayed in the 
Endpoint URL.

BW-Salesforce-100052: Cannot find a target server. The address in the incoming message is [ %1 ]

errorRole BW-Plugin Check the EndPoint URL and make sure it is 
correct.

BW-Salesforce-200001: The session for User %1 timed out. Old sessionId is [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200002: The session for User %1 was refreshed. Old sessionId is [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200003: User %1 is logging in...

infoRole BW-Plugin

BW-Salesforce-200004: This is the %2 time(s) during the rotation %3 for user %1 trying to login

infoRole BW-Plugin

BW-Salesforce-200005: Login failed for User %1

infoRole BW-Plugin

BW-Salesforce-200006: Login succeeded for User %1. SessionId is [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200007: Get session for User %1 immediately. SessionId is [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200008: Mechanism Retry of Getting Session makes User %1 to sleep for %2 
seconds

infoRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200009: Request SOAP Message Sent:\n%1

infoRole BW-Plugin

BW-Salesforce-200010: Response SOAP Message Received:\n%1

infoRole BW-Plugin

BW-Salesforce-200011: Start to operate %1. Process Id: [ %2 ]. Engine Name: [ %3 ]

infoRole BW-Plugin

BW-Salesforce-200012: Renewed session in %1 activity

infoRole BW-Plugin

BW-Salesforce-200013: Ready to execute the operation [ %1 ]...

infoRole BW-Plugin

BW-Salesforce-200014: Ready to execute the operation [ %1 ]. The related input count is [ %2 ]...

infoRole BW-Plugin

BW-Salesforce-200015: Got the returned data of the operation [ %1 ]. The related sObject(s) count 
is [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200016: Finished the [ %1 ] operation execution

infoRole BW-Plugin

BW-Salesforce-200017: Entered the error generating process. The StackTrace: { %1 } Message: [ 
%2 ]. FullClass: [ %3 ]. ProcessStack: { %4 }. Data String: [ %5 ]

debugRole BW-Plugin

BW-Salesforce-200018: End of the error generating process. ExceptionCode: [ %1 ]. 
internalFaultcode: [ %2 ]. ExceptionType: [ %3 ]. ExceptionMsg: [ %4 ]. DetaildInfo: [ %5 ]

debugRole BW-Plugin

BW-Salesforce-200019: Detailed information for handling an Application Exception: [ %1 ]

debugRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200020: Detailed information for executing the Create/Upsert operation: 
serverUrl: [ %1 ]. sessionId: [ %2 ]. isCreate: [ %3 ]. externalIDFieldName: [ %4 ]

debugRole BW-Plugin

BW-Salesforce-200021: Detailed information of the input data: Type: [ %1 ]. Id: [ %2 ]. otherData: 
[ %3 ]

debugRole BW-Plugin

BW-Salesforce-200022: End of executing [ %1 ]. Process Id: [ %2 ]. Engine Name: [ %3 ]

infoRole BW-Plugin

BW-Salesforce-200023: Trying to refresh the session...

infoRole BW-Plugin

BW-Salesforce-200024: Refreshed the session. Be ready to retry the operation...

infoRole BW-Plugin

BW-Salesforce-200025: The batchSize was not assigned with a valid value. It will be given a 
default value

warnRole BW-Plugin

BW-Salesforce-200026: A new operation batch will be performed. Batch size: [ %1 ]

infoRole BW-Plugin

BW-Salesforce-200027: End of executing a batch of sObject(s). The related sObject(s) count is: [ 
%1 ]

infoRole BW-Plugin

BW-Salesforce-200028: Retry to execute the [ %1 ] operation after [ %2 ] milliseconds

infoRole BW-Plugin

BW-Salesforce-200029: Retry to execute the [ %1 ] operation immediately

infoRole BW-Plugin

BW-Salesforce-200030: Detailed information for executing the Delete operation: serverUrl: [ %1 
]. sessionId: [ %2 ]. count of the input IDs: [ %3 ]

Message Role Category Resolution (Cont’d)
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debugRole BW-Plugin

BW-Salesforce-200031: Detailed information for executing the Query/QueryMore operation: 
serverUrl: [ %1 ]. sessionId: [ %2 ]. queryString: [ %3 ]. queryLocator: [ %4 ]

debugRole BW-Plugin

BW-Salesforce-200032: Be ready to execute the operation [Query], the query string is [%1]...

infoRole BW-Plugin

BW-Salesforce-200033: Be ready to execute the operation [QueryMore], the query locator is 
[%1]...

infoRole BW-Plugin

BW-Salesforce-200034: The input of 'salesforceConnection' is empty. The operation can not be 
retried when an invalid session exception occurred

warnRole BW-Plugin

BW-Salesforce-200035: All the data has been returned from the server. The count of the returned 
sObject(s) is: [ %1 ]

infoRole BW-Plugin

BW-Salesforce-200036: All the data has not been returned yet from the server. Be ready to 
process the next subset...

infoRole BW-Plugin

BW-Salesforce-200037: Set the shared variable for processing the next subset. firstQuery: [ %1 ]. 
queryMoreLocation: [ %2 ]. sessionRenewed: [ %3 ]. salesforceConnection: [ %4 ]

debugRole BW-Plugin

BW-Salesforce-200038: The session has been renewed. Set the shared variable for processing the 
next subset. serverUrl: [ %1 ]. sessionId: [ %2 ]

debugRole BW-Plugin

BW-Salesforce-200039: The shared variable used by subsets has been refreshed

debugRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200040: Detailed information for executing the Update operation: serverUrl: [ %1 
]. sessionId: [ %2 ]. count of the input sObject(s): [ %3 ]

debugRole BW-Plugin

BW-Salesforce-200041: Detailed information for executing the Upsert operation: serverUrl: [ %1 
]. sessionId: [ %2 ]. externalIdFieldName: [ %3 ]

debugRole BW-Plugin

BW-Salesforce-200042: The operation [ %1 ] returned [ %2 ] results, including [ %3 ] results with 
errors

infoRole BW-Plugin

BW-Salesforce-200043: No Information

infoRole BW-Plugin

BW-Salesforce-200044: The configured BatchSize is [ %1 ] that will be fixed to the minimum 
(200)or maximum (2000) BatchSize

warnRole BW-Plugin

BW-Salesforce-200045: The configured SubsetSize is [ %1 ] that will be fixed to the minimum 
(1)or maximum (10) SubsetSize

warnRole BW-Plugin

BW-Salesforce-200046: Processing in subsets. Batch size is [ %1 ], subset size is [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200047: The configured BatchSize for [ %1 ] operation is [ %2 ] that will be fixed 
to the minimum (200) or maximum (2000) BatchSize

warnRole BW-Plugin

BW-Salesforce-200048: The configured SubsetSize for [ %1 ] operation is [ %2 ] that will be fixed 
to the minimum (1) or maximum (10) SubsetSize

warnRole BW-Plugin

BW-Salesforce-200049: The configured BatchSize is [ %1 ]

infoRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200050: Be ready to process the operation in subsets for [ %1 ] activity. The 
configured BatchSize is [ %2 ], and the SubsetSize is [ %3 ]

infoRole BW-Plugin

BW-Salesforce-200051: The end of the [ %1 ] activity

infoRole BW-Plugin

BW-Salesforce-200052: Retry to execute the [ %1 ] operation in [ %2 ] seconds

infoRole BW-Plugin

BW-Salesforce-200053: This is the [ %2 ] time(s) during the rotation [ %3 ] for trying [ %1 ] 
operation

infoRole BW-Plugin

BW-Salesforce-200054: Processing in subsets is finished for [ %1 ] activity

infoRole BW-Plugin

BW-Salesforce-200055: Be ready to process the operation for [ %1 ] activity

warnRole BW-Plugin

BW-Salesforce-200056: Processing the operation is finished for [ %1 ] activity

infoRole BW-Plugin

BW-Salesforce-200057: Recoverable errors returned with the records. Please find the information 
of the related records in the log

infoRole BW-Plugin

BW-Salesforce-200058: --------------------------------------------------------------------------

infoRole BW-Plugin

BW-Salesforce-200059: The [ %1 ] activity ends up with the error(s)

warnRole BW-Plugin

BW-Salesforce-200060: No error information is available in the returned data

warnRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200061: The results have been returned successfully. There is no error in the 
returned data

infoRole BW-Plugin

BW-Salesforce-200062: End of executing a batch of the operation for [ %1 ] activity. [ %2 ] 
sObject(s) have been returned

infoRole BW-Plugin

BW-Salesforce-200063: End of executing a batch of operation for activity [ %1 ], but no sObject 
returned

warnRole BW-Plugin

BW-Salesforce-200064: Salesforce Outbound Message Listener on [ %1 ] was initialized 
successfully

infoRole BW-Plugin

BW-Salesforce-200065: No input data under the node [ %1 ] at the run-time for activity [ %2 ] is 
available. An empty result will be returned directly

warnRole BW-Plugin

BW-Salesforce-200066: The operation name has been changed from [ %1 ] to [ %2 ]

debugRole BW-Plugin

BW-Salesforce-200067: The session refreshing operation could not be performed since the 
external session configuration has been used

warnRole BW-Plugin

BW-Salesforce-200068: The Salesforce Outbound Message Listener on [ %1 ] received a message

infoRole BW-Plugin

BW-Salesforce-200069: The Salesforce Outbound Message Listener on [ %1 ] sent an Ack: [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200070: The Salesforce Outbound Message Listener on [ %1 ] enabled SSL. The 
Keystore File [ %2 ] was used

infoRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200071: The Salesforce Outbound Message Listener on [ %1 ] required Client 
Authentication. The Trusted Certificates Folder [ %2 ] was used

infoRole BW-Plugin

BW-Salesforce-200072: Be ready to execute the operation [QueryMore] if any nested sObject 
exists...

infoRole BW-Plugin

BW-Salesforce-200073: Be ready to execute the operation [QueryMore] for the node [ %2 ] with 
the query locator [ %1 ]... 

infoRole BW-Plugin

BW-Salesforce-200074: End of executing a batch of operation for the node [ %2 ] of [ %1 ] activity, 
but no sObject is returned

warnRole BW-Plugin

BW-Salesforce-200075: End of executing a batch of the operation for the nested node [ %3 ] of [ 
%1 ] activity. [ %2 ] sObject(s) have been returned

infoRole BW-Plugin

BW-Salesforce-200076: Using the 'timeout' property. The timeout value is: [ %1 ]ms

infoRole BW-Plugin

BW-Salesforce-200077: The following Request SOAP Message will be sent \n %1 

debugRole BW-Plugin

BW-Salesforce-200078: Set the default host to [ %1 ]

infoRole BW-Plugin

BW-Salesforce-200079: Set the default binding host to NULL

infoRole BW-Plugin

BW-Salesforce-200080: An HTTP message with the error code [ %1 ] has been returned to the 
client

infoRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200081: More than one CN are generated from the incoming HTTP message. 
Current CN list contains [ %1 ] items

warnRole BW-Plugin

BW-Salesforce-200082: Client Authentication passed. The following CN(s) is/are in the 
incoming HTTP message: [ %1 ]

infoRole BW-Plugin

BW-Salesforce-200083: The following CN(s) is/are generated from the design-time configured 
leaf certificates: [ %1 ]

debugRole BW-Plugin

BW-Salesforce-200084: At run-time, the following CN(s) generated from the design-time 
configured leaf certificates is/are fetched: [ %1 ]

debugRole BW-Plugin

BW-Salesforce-200085: Doing client CN verification...

debugRole BW-Plugin

BW-Salesforce-200086: The timeout value for this call are [ %1 ] milliseconds

infoRole BW-Plugin

BW-Salesforce-200087: The Salesforce Outbound Message Listener received a message whose 
ServiceEntry URL is [ %1 ]. Sending an Ack: [ %2 ]

infoRole BW-Plugin

BW-Salesforce-200088: A certificate is expired. This certificate will be ignored. The Subject DN: 
[ %1 ]

warnRole BW-Plugin

BW-Salesforce-200089: A certificate is not valid for the moment. This certificate will be ignored. 
The Subject DN: [ %1 ]

warnRole BW-Plugin

BW-Salesforce-200090: Validating the certificate defined at design-time...

infoRole BW-Plugin

Message Role Category Resolution (Cont’d)
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BW-Salesforce-200091: Validating the certificate received at run-time...

infoRole BW-Plugin

BW-Salesforce-200092: The Salesforce Outbound Message Listener received a message whose 
ServiceEntry URL is [ %1 ]

infoRole BW-Plugin

BW-Salesforce-200093: Proxy setting in use, the proxyHost:[ %1 ], proxyPort:[ %2 ], proxyUser:[ 
%3 ], proxyPwd:[ %4 ], proxyTimeout(min): [ %5 ]

infoRole BW-Plugin

BW-Salesforce-200094: End of executing a batch of operation for activity [ %1 ], but no sObject 
returned

infoRole BW-Plugin

BW-Salesforce-200095: End of executing a batch of operation for the node [ %2 ] of [ %1 ] activity, 
but no sObject is returned

infoRole BW-Plugin

BW-Salesforce-200096: Can't generate the global variables [ %1 ] and [ %2 ] for the 
OutboundMessageListener, please manually add them if needed

warnRole BW-Plugin Manually add these two global variables. 

Message Role Category Resolution (Cont’d)
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Appendix B Configuration Templates for Properties 
Setting

This appendix provides the configuration templates contents for the properties 
setting.

Topics

• Configuration Template of the properties.cfg File, page 130

• Configuration Template of the bwengine.xml File, page 131
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Configuration Template of the properties.cfg File

The properties.cfg file is available in the SFDC_HOME\templates directory.

The content of the default file shows below: 
## Log status settings. The first three properties are generic 
properties provided by TIBCO BusinessWorks.

Trace.Info.*=true

Trace.Error.*=true

Trace.Warn.*=true

com.tibco.plugin.salesforce.debug=false

## Retrying function settings

com.tibco.plugin.salesforce.retry.rotationPolicy=2,5,20

com.tibco.plugin.salesforce.retry.rotationNumber=1

## Timeout value in millisecond for each SOAP operation call

com.tibco.plugin.salesforce.invoke.timeout=15000
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Configuration Template of the bwengine.xml File

The bwengine.xml file is available in the 
BW_HOME\lib\com\tibco\deployment directory.

The following content in the file is related to the configuration of TIBCO 
ActiveMatrix BusinessWorks Plug-in for Salesforce.com: 
<!--startBWSalesForcePluginProperties-->

<property>

   <name>Trace Debug Control for BW Salesforce Plug-in</name>

   <option>com.tibco.plugin.salesforce.debug</option>

   <default>false</default>

   <description>Turn the log in Debug role ON or OFF for the 
BusinessWorks Salesforce Plug-in only</description>

</property>

<property>

   <name>BW Salesforce Plug-in rotation policy</name>

 <option>com.tibco.plugin.salesforce.retry.rotationPolicy

</option>

   <default>2,5,20</default>

   <description>Define the rotation policy for BusinessWorks 
Salesforce Plug-in used in the retrying function </description>

</property>

<property>

   <name>BW Salesforce Plug-in rotation number</name>

   <option>com.tibco.plugin.salesforce.retry.rotationNumber

</option>

   <default>1</default>

   <description>Define the rotation policy for BusinessWorks 
Salesforce used in the retrying function

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in default proxy host</name>

   <option>com.tibco.plugin.salesforce.proxyHost</option>

   <default></default>

   <description>Define the default proxy host for BusinessWorks 
Salesforce Plug-in
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</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in default proxy port</name>

   <option>com.tibco.plugin.salesforce.proxyPort</option>

   <default></default>

   <description>Define the default proxy port for BusinessWorks 
Salesforce Plug-in

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in default proxy user</name>

   <option>com.tibco.plugin.salesforce.proxyUser</option>

   <default></default>

   <description>Define the default proxy user for BusinessWorks 
Salesforce Plug-in

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in default proxy password</name>

   <option>com.tibco.plugin.salesforce.proxyPwd</option>

   <default></default>

   <description>Define the default proxy password for BusinessWorks 
Salesforce Plug-in

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in default proxy timeout</name>

   <option>com.tibco.plugin.salesforce.proxyTimeout</option>

   <default></default>

   <description>Define the default http request timeout value for 
BusinessWorks Salesforce Plug-in

</description>

</property>

    

<!--

<property>
TIBCO ActiveMatrix BusinessWorks Plug-in for Salesforce.com User’s Guide



Configuration Template of the bwengine.xml File | 133
   <name>BW Salesforce Plug-in proxy host</name>

   <option>java.property.http.proxyHost</option>

   <default></default>

   <description>Define the proxy host for BusinessWorks Salesforce 
Plug-in

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in proxy port</name>

   <option>java.property.http.proxyPort</option>

   <default></default>

   <description>Define the proxy port for BusinessWorks Salesforce 
Plug-in

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in proxy user</name>

   <option>java.property.http.proxyUser</option>

   <default></default>

   <description>Define the proxy user for BusinessWorks Salesforce 
Plug-in

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in proxy password</name>

   <option>java.property.http.proxyPassword</option>

   <default></default>

   <description>Define the proxy password for BusinessWorks 
Salesforce Plug-in

</description>

</property>

    

<property>

   <name>BW Salesforce Plug-in proxy timeout</name>

   <option>java.property.http.timeout</option>

   <default>3</default>

   <description>Define the http request timeout value for 
BusinessWorks Salesforce Plug-in
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</description>

</property> 

 -->

    

<property>

   <name>BW Salesforce Plug-in invoke timeout</name>

   <option>com.tibco.plugin.salesforce.invoke.timeout</option>

   <default>15000</default>

   <description>Define the invoke timeout for BusinessWorks 
Salesforce Plug-in used in invoking web service

</description>

</property>

<!--endBWSalesForcePluginProperties-->

Changing Log Levels in the bwengine.xml File

If you want to manually add the Trace.Info.*, Trace.Error.*, and 
Trace.Warn.* properties for the log levels, add the following lines in the 
bwengine.xml file. 
<property>

   <name>Trace Info Control</name>

   <option>Trace.Info.*</option>

   <default>true</default>

   <description>Turn the log in Info role ON or OFF</description>

</property>

<property>

   <name>Trace Error Control</name>

   <option>Trace.Error.*</option>

   <default>true</default>

   <description>Turn the log in Error role ON or OFF</description>

</property>

<property>

   <name>Trace Warn Control</name>

   <option>Trace.Warn.*</option>

   <default>true</default>

The comments at the beginning and end of the above content must not be modified. 
<!--startBWSalesForcePluginProperties-->

<!--endBWSalesForcePluginProperties-->
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   <description>Turn the log in Warn role ON or OFF</description>

</property>
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